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FACTS ONTOR

DISTRIBUTION SOLUTIONS

Using FACTS

Using FACTS provides general information about the basic features of
each major program in the system.

FACTS User Basics

User interfaces

Each FACTS user can work in one of two interfaces: character or
graphical. Those who have used FACTS in the past will recognize the
character interface. The graphical interface offers more of the look, feel
and functionality of a Windows-based system.

This dual interface capability makes it possible to set up individual
users with an interface that best meets the needs of their respective job
functions. It also helps companies upgrading from earlier versions of
FACTS or other character-based systems to minimize hardware
investments.

Which interface to use

Your System Administrator or Local FACTS Affiliate will configure
each FACTS workstation for the appropriate interface.

Some workstations do not support graphical interfaces. If you perform
your job on such a workstation (a standalone terminal with no hard
drive or memory of its own), your workstation will be configured to
use the character interface.

PC users can work in either interface. PCs running on a Unix system
can run the graphical interface by installing WindX and turning on the
Graphical User flag in User F/M.

PCs running on a Windows NT network can be set to graphical by
turning on the Graphical User flag.
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Basic system structure

1-2

The FACTS system is a suite of 22 highly integrated modules that
address asset management, customer service, financial management
and electronic commerce. The modules are:

Accounts Payable Manufacturing Control
Accounts Receivable Payroll
Archive Purchase Orders
EDI Report Writer
Executive Information System Sales Analysis
FaxLink with VSI-FAX Sales Orders
General Ledger Service & Repair
Internet On-Ramp Shipping for UPS (Clippership)
Inventory Control System Management
Job Cost TeleFACTS

Unform

Each of the FACTS modules contains a complement of programs to
help you manage these four major business categories. The six types of
FACTS programs are:

Entries File Maintenances
Reports, Registers & Updates Searches
Inquiries Selectors/ menus

Entry programs (E) enable you to enter data transactions into the
system. For example, to enter an order, purchase order or accounts
payable invoice you will use an entry program.

File maintenance (F) programs form the foundation of the FACTS
system. Use these programs enable you to set controls and parameters.
They also allow you to enter vital information that can later be recalled
throughout the system. For example, information about customers,
items and vendors is entered and maintained by using file maintenance
programs.

Inquiry (I) programs allow you to look up review information stored in
the system. Notes may be entered for customers, vendors, items,
employees and banks. Notes are entered through the appropriate
inquiry program or the Notes Entry (SME710) program. Notes are
displayed in inquiry programs, Sales Orders and Purchase Orders entry
programs, Item F/M (ICF910) and Customer F/M (ARF910), and print
on the appropriate notes report.

Print (P) programs are used to print forms, such as invoices, checks and
statements. These types of programs frequent output to preprinted
forms, or they can be output via Unform.

Report or register (R) programs are used to print information in report
format. Reports print information, but they do not update the system.
The Open Receivables Report is an example of this type of program. On
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the other hand, registers print a report and then offer you the option to
update, or post the register information to the appropriate files. For
example, the SO Daily Sales Register lists all the invoices that have been
printed since the last time you ran the register. If you choose the
optional update the register offers, the invoices then post to the open
receivables file, sales tax file, etc.

Update (U) programs only update information throughout the system.
They do not produce a report. An example is the AR End-of-Period
Update program, which you run to close out the Accounts Receivable
for the period. This update increments the AR period, zeroes out
month-to-date sales figures, etc.

Selector or menu (S) programs enable you to navigate through the
FACTS system so you can access the programs you need.

Assuming your system has not been modified, the FACTS Master Menu
is the first menu you see after you sign into the system.

To tell which type of program you're in, look at the program
designation in the title bar.

L2 PO Statuz Repor [POR710)
S

The third letter in the designation indicates the program type. In this
case, the program is a report.

The program designation also appears in the upper-right hand corner
of the menus when you highlight a program in the left navigation
panel.

Program designations provide other useful information. The first two
letters represent the module code. The digits at the end of the
designations represent program numbers. They also indicate on which
menu the program can be found.

For instance, if the Purchase Orders Reports menu designation is
POS700, then all the programs on that menu will start with a 7 as well.

Important Keys

The keys marked F1, F2, F3 and F4 or I, I, IlIl and IV (depending on the
keyboard) are the function or control keys. If these keys provide an
operation in the programs being used, the key number and its
operation are displayed in the user prompt. For example, normally the
F4 key backs up to the previous input. These keys are functional when
the user prompt gives the option to use them. When the user presses
the function key, the function displayed in the prompt is executed
immediately without the user having to then press CR or enter. A
displayed prompt might be F4 - Backup. Whenever F4 is displayed it
always means the user may back up to the previous input or end the
program depending on what the prompt displays. Other examples of
these keys are F3 - to display the next record in a file, F4 - end the
program or F2 - perform a search.

Also note that CR in prompts refers to the ENTER or RETURN key on
the keyboard. For example, when entering data, the user types the data
and then presses CR. Once again, when using a function key, pressing
CR is not necessary. If the prompt gives the option of F4-end, and F4 is
pressed, the program ends immediately.
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On-Line Access and Edit Keys

While signed into FACTS, there are specific on-line functions that can
be accessed by pressing a “Hot Key.” The “Hot Keys” that invoke the
functions are defined by terminal in the Terminal F/M option in the
System Management Module. The available functions are:

On-Line Calendar

You can invoke the on-line calendar from anywhere in the system by
pressing the hot key defined to it. The default hot key for the FACTS
System is CTL+D, but you can change this in the Terminal F/M Screen.
You can also copy a date into the system from the calendar by pressing
the F3 key if you are in a date field.

On-Lline Calculator

You can invoke the on-line calculator from anywhere in the system by
pressing the hot key defined to it. The default hot key for the FACTS
system is CTL+V, but you can change this on the Terminal F/M Screen.
You can also copy a total from this calculator into any amount field in
the system by pressing the F10 key. This calculator operates similar to
an adding machine in that the operation (+, -, x, / or *) be entered prior
to entering the number.

SO Quick Look

You can invoke a quick search from the SO entry programs by pressing
the hot key defined to it. The default hot key for the FACTS system is
CTL+B, but you can change this on the on the Terminal F/M Screen.
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Using the PDF Manuals

Each FACTS module has its own manual, which is distributed in
Acrobat PDF format on the PDF Documentation Library CD.

FACTS Manuals are distributed in PDF format to allow you greater
flexibility. You can choose to:

e Print the entire set of manuals at a copier service, such as Kinkos,
AlphaGraphics or Sir Speedy. The license agreement allows you to
print a set of manuals for each license purchased. So if you
purchased a five-user license, you can print five sets of manuals.

o Print the section or pages you need as you go. This is the beauty of
electronic documentation distributed on CD-ROM. You decide how
much paper you want to use. Find the parts of the documentation
you need, or want to keep handy, and output those pages to your
office printer.

¢ Go paperless. Copy the PDF library to a network drive or to a
user’s local hard drive so they can use the documentation like an
electronic library.

You may want to start with the Welcome?7 page, which provides links
to each of the manuals via their Table of Contents. The page also
provides basic instructions for printing the manuals and using the
Search feature to find topic

How the manuals are organized

All of the FACTS manuals contain the following sections: system
overview, program descriptions, references, glossary of terms, and
sample reports. The System Management manual includes sections on
Job Stream and Office Automation.

Table of Contents

The TOCs in each manual reflect the menu structure used in FACTS.
This makes it easy to find a program if you know which menu it’s on.

Preface

These sections provide general information about the manual and
preprinted forms.

System Overview

These sections often include an overview of the module, a list of
program features, definitions of important terms used in the module, a
general process flow, and recommended operating procedures. Flow
charts help illustrate the information flow through the programs and
the modules interaction with other FACTS modules.

Program descriptions

These chapters detail each program in the module and comprise the
bulk of the content for each manual. Each program description
includes the functions, user inputs, technical notes and a screen print.
The programs are listed in the order that they appear on the menu.
There is an overview preceding each menu that explains the interaction
of the programs within the menu.

Copyright © 1984-2005 Infor, Inc



1-6

Procedures

For many entry, register, and inquiry programs, the topics containing
the phrase “How to” in the topic title are step-by-step procedures for
using the program.

References (Appendix A)

Throughout the documentation the phrase (ref. #) is used to refer to the
Appendix called “References.” References are generic notes that may
apply to more than one prompt or feature throughout the manual.
References are used to prevent the same information from being
repeated one program to the next. The notes are consolidated in the
Appendix and referenced throughout each manual.

Glossary of Terms (Appendix B)
The glossary provides a definition of terms used in the manual and
related terms from other modules.

Sample Reports (Appendix C)

This section provides a sample printout of most of the reports and

prints in the module. A directory is included that lists each report and
the page number in the section.

Conventions used in the manuals
The following elements are used through the FACTS documentation.

= Indicates a statement or paragraph that is critical
to the installation process.

bold items When used in a set of instructions, bold type
indicates items that need to be selected, such as
directories, files, buttons, etc.

Start DPrograms ZWind X Italicized words connected by arrows indicate a
series of selections you need to make to reach a
menu item either in FACTS or Windows.

Boxed text in margins | Contain important background information, such
as terminology or technical tips.

CUI This acronym stands for Character User Interface.
This is the traditional text-based interface.

GUI This acronym stands for Graphical User Interface.
It is used throughout the PDF library to reference
the Windows version of the program.

Copyright © 1984-2005 Infor, Inc.



Backing up the system

Your company’s computer system represents a major investment. This
investment needs to be protected as much as possible. You can protect
your computer hardware through preventive maintenance periodically
provided by your hardware vendor.

Similarly, you can protect your software investment by performing
routine backups. A backup is the replication of information in your
computer system onto media such as cartridge tapes or diskettes.
Think of backups as insurance: in the event of hardware failure, fire,
electrical failure, user errors, theft or any other acts of God (tornado,
hurricane, flood, lightening, etc.), it is great to have the insurance to
bear the financial burden.

The more frequent the backup, the better the insurance. If you lose data,
through hardware problems or through user error, it can be restored
from your backup. However, any work done between the time of the
last backup and the data loss will need to be re-entered. As soon as
your system is installed, establish a backup procedure. Discuss the
procedure with your local FACTS office to make sure the procedure is
satisfactory.

Make sure the procedures are in place before anyone begins entering
data so that you can backup additions and changes made to any data
files.

We highly recommend daily back ups.

We also recommend backing up to tape. It is faster and more reliable
than diskettes.

Backup types

Your computer system stores different types of information.
Depending on the type of computer system installed, you will have an
operating system, a language, application programs, data, and other
miscellaneous software installed (i.e. Third Party Products, word
processing software and documents, spreadsheets, etc.)

Make sure you backup the following types of information:

- FACTS Data (your company files such as the customer files, item
files, etc.)

- FACTS Programs and Data

- Full System (all of the information above plus the operating
system, language, word processing software, spreadsheet
program, etc.)

Frequency of Backups

Remember, restoring backed up files returns your system to the state it
was in when the backup was made. All information that has been
entered or changed since the last backup occurred will have to be re-
entered. Therefore, the more frequently you back up your system, the
less information you will have to re-key in the case of a backup
restoration.
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Based on how conservative your company operates determines how
frequently you need to perform backups. The following table
illustrates our recommendation for backup frequency:

Backup Type

Frequency

*Tape Rotation

Data Daily 5 sets - one for each week of the
month
(one set=one tape/day)
Programs & After any software 3 sefs
Data enhancement, ( t= ; / h)
upgrade, bug fix, file one sef=one fape/mon
restructuring or,
Minimum of once a
month; run prior to end-
of-period processing
Full System Weekly and, 5 sets - one for each week of the

Before and after a
software upgrade

month

(one set=one tape/week)

*the calendar schedule shows when to rotate tapes

The above recommendations only apply to FACTS. If you have other
third party programs that work with FACTS or other productivity
programs, such as word processing or spreadsheet software, you need
to backup these programs and data as well.

Scheduling

Once you have planned the type and frequency of your backups,
establish a schedule (day and time) for making backups and adhere to
the schedule. Give your users advanced warning about the schedule so
they can plan accordingly.

We recommend that all users sign off the system before backup begins.
Try to perform backups first thing in the morning or at the end of the

day.

Tape Rotation

1-8

Tape rotation requires that you keep multiple sets of backup tapes and
that you alternate their use at regular intervals. If you encounter a
problem with a tape, do not use the previous set of tape(s), use a new
tape and label it to avoid confusion at the next backup.

The following schedule illustrates a recommended backup schedule
with tape rotation for a business with a five-day work week.
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Sun Mon Tues Wed Thurs Fri Sat
1 2 3 4 5 6 7
M1
&Dla D2a D3a D4a Wi
8 9 10 11 12 13 14
Dlb D2b D3b D4b W2
15 16 17 18 19 20 21
Dlc D2c D3c D4c W3
22 23 24 25 26 27 28
D1d D2d D3d D4d W4
29 30 31
M2
Dle D2e & D3e D4e W5
Tapes D1a - D4a are labeled Monday to Thursday and are used for
daily backup of FACTS data. Five sets are required for a maximum of 5
weeks in a month. The next month you simply rotate back to Dla
through D4a, D1b through D4b, etc.
Tapes W1 -W5 are used weekly for full system backups. Full system
backups are scheduled for Friday of each week. When all five tapes
have been used, rotate back to tape W1.
Tapes M1, M2, & M3 are used for monthly backups of programs and
data. Monthly backups are scheduled at the beginning of the month.
When all three tapes are used, rotate back to M1, thus keeping three
complete sets of backup tapes (previous month, 2"d previous month, an
3rd previous month) for programs and data. To be very conservative,
you may want to keep a separate tape for each month of the year, thus
having twelve backup tapes verses three.
Caution: Separate your tapes according to backup type. Do not mix
backup types on the same tape!
Copyright © 1984-2005 Infor, Inc 1-9




After the backup
First and foremost, verify that the backup actually happened.

Many systems ship with backup scripts that verify the tape after the
backup has been performed. Some suggested methods of tape
verification:

e Set up a UNIX script that creates an extra file. Make sure it’s
the first file on the backup tape. This file should contain the
time and date stamp of when the backup was performed. This
gives you at-a-glance verification.

e Set up a script to send UNIX mail to root. Set it up so that the
message contains a list of files that were written to the backup
tape. The System Administrator can compare the “backup”
mail each day and against the tape to make sure the two
reconcile.

¢ Look for a file with the current time and date. When a UNIX
system writes to a file, it normally updates the time and date
stamp on that file. For example, say a user entered new
customers (ARCUST) to the system prior to the backup at the
end of business Friday, July 1. If the date on ARCUST is
Friday, July 1, the backup was successful.

Another method may work better for you. In any case, make sure the
back up actually happened.

Tape Labeling

Make sure you develop a system for labeling tapes to prevent
overwrites. Labels should include the following information:

Type: DAILY BACKUP

Tape 1 of 2
Tape # DIA (Monday)
Date: (mark in pencil)

Pathname: (directory &/or files)

Off-Site Protection

Store your backup tapes off-site. This provides an additional level of
protection from natural disasters. At the minimum, store your weekly
and monthly backups off-site.
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Using Graphical FACTS

Signing into FACTS from PCs

When you start up FACTS, the first screen that appears is the Sign-in
Screen. This screen prevents unauthorized individuals from accessing

your system.

PC users automatically see the graphical version of the Sign-in screen
even if they are set up to use the character interface. If this is the case,
the rest of FACTS will appear in character format, even though the

Sign-in screen is graphical.

Click the buttons
below to Sign-On
and End or to get
contact information____|
on your Local

FACTS Affiliate.

™\ FACTS 7 - Sign On

FACTS

DISTRIBUTION SOFTWARE

User Code D
Password |:|
Company |:|

T [ sinon [ End

)

[ FACTS Development

)

(INlDﬁ)

To sign on, enter your

e User Code
e Password

Version 7.5
Gopyright (c) 1984-2004_ infor All Rights Reserved.

The copyright line at the bottom of
the screen hyperlinks to the
FACTS Copyright Notice.

e Company Number — initially, the company number defaults to
01. Afterward, it defaults the last company number entered.

Then click Sign-On, or press Alt+S.

To exit from this screen, click End.
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Using the GUI menu system

The graphical menu interface consists of a header, a main screen and a
navigation panel.

TS* Master Menu (MMS000)

(INII:IE)

ULWITEC) FACTS 7.5 Development- Company 01 0301/05- 1115 am

*FACTS* Master Menu

& g B

Sales Orders Inwventony Control Purchase Orders  Accounts Receivable Accounts Payable

: s Aperum.
é % By The Clear Choice in

Distribution Software

System

Office Automation Job Straam
Managemant

w OB

Job Cost TeleFACTS Report Writer V
>

@ Access Code M

General Ladgar Sales Analysis

£

Manufacturing
Cantral

FaxLink

The header contains the system date and time, user and terminal ID, the
program name and the FACTS logo.

The navigation panel and main screen enable you to view two menus at
once — the one you're currently in and the one directly below it.

Use the navigation panel to navigate to a menu.

Use the main screen to select

Examples:
Sales Orders... This menu item links to another menu, in this case the Sales Order menu
Order Entry This menu item links to the Order Entry program.

Double-click a menu item to select it.
o If the selection links to a program, the program opens.

o If the selection links to another menu, the menu appears in the
navigation panel. Depending on which type of menu item is
highlighted (a program or a menu), the main screen may contain
buttons that lead to programs or submenus.

The navigation panel also contains a BACK button, which works like
F4. It takes you back to the menu immediately preceding the one that
appears in the navigation panel.

You can also select programs and submenu by clicking on the buttons
in the main screen.
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Menu time outs

System Administrators and Implementation Consultants can set the
menu system to “time out” and return to the Sign on Screen if it is
inactive for the designated amount of time.

This is a security feature that helps prevent unauthorized users from
accessing sensitive data at unattended stations.

For instance, your local FACTS Affiliate may set the menu to time out if
it is inactive for five minutes. If you take a lunch break and forget to log
off, FACTS logs off for you.

Navigating with your keyboard

Keyboard shortcuts are provided where possible as alternatives to the
mouse. We refer to these shortcuts as Alt keys since the shortcut
becomes available when you press the Alt key on your keyboard.

Example: On most OK buttons, you can press Alt+O to select the button
with your keyboard.

Arrow keys: Move you up and down through in the navigation panel
and the main screen. If the main screen contains two columns of
buttons, the right and left arrows move you between the two.

Tab key: Moves you from the navigational panel to first button on the
main screen. SHIFT+TAB performs the reverse of the TAB key.

Page up and down keys: Move you up and down four selections at a time
in the navigation panel.

Access codes

Access codes are shortcuts to different menus and programs
throughout the system. At initial installation, the system contains a
number of preset access codes for each module on the master menu and
Administrators can set up additional codes as needed (System
Management-> Menu Setup-> Program E/M.)

To use access codes in the graphical menu system, type in an access
code on you keyboard anywhere in the FACTS menu system and press
Enter. As you begin typing the code, the FACTS logo disappears and an
entry box appears in its place along with the access code entered.

Preset FACTS Access Codes

AP Accounts Payable MM  Master Menu

AR  Accounts Receivable OA Office Automation
CS  Counter Sales PO Purchase Orders
EDI Electronic Data Interchange PR Payroll

FL  FaxLink RW  Report Writer

GL  General Ledger SA Sales Analysis

IC Inventory Control SM System Management
JC Job Cost SO Sales Orders

JS Job Stream SR Service and Repair
MC  Manufacturing Control TF TeleFACTS
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Access codes for standard menus

To access the Inquires menu in any module, add an I to the access code
for the main module. Example: Type ARI to access the Accounts Receivable
Inquiries menu.

To access the Reports & Prints menu in any module, add an R to the
module’s access code. Example: Type ICR to access the Inventory Control
Reports menu.

To access the End of Period menu in any module, add an E to the
module’s access code. Example: Type POE to access the Purchase Orders
End of Period menu.

To access the File Maintenance menu in any module, add an F to the
module’s access code. Example: Type SOF to access the Sales Orders
File Maintenances menu.

To access the Infrequent File Maintenance menu in any module, add
an IF to the module’s access code. Example: Type GLIF to access the
General Ledger File Maintenances menu.

S Menus may be restricted to certain users. Access codes do not work
if a menu is restricted.
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searches ]

Searches allow you to find specific information, such as customer
number, item number, General Ledger number, etc.

Access searches by choosing the Search button (shown above) or by
pressing F2 where the search option is available.

Select information from the browser by highlighting the line and
selecting OK. You can also double click a line to select it.

Options  E=port  Print

Alpha | Contact | Phane Customar | Class
GoTao N

Filter

Keywords | Or | | Starts with I

Class I #| zipcode SalespersoniTerr. I |

1 c188 R

2 C181 Deluxe Equipemnt Warehouse Douglasville, GA Sam J

3 G182 Roark Architectural, Inc. ficworth, GA Howar

L G183 Taggart Transcontinental Waco, TX Dagne

5 C184 Barnes Machinery & Equipment Atlanta, GA James

6 G185 Dallas Furniture Mart Fort Worth, TX Tim M

7 G186 Maloney's Metal Products Co. Dallas, TX Jerry

8 G167 Central Georgia Materials Co. Douglasville, GA Steve

9 C188 Sims Hardware Dallas, TH Jeff

18 C189 Southside Plumbing Los Angeles, CA Lewis
11 C118 Texas HMaterial Handling Co. Dallas, TX poug x|
Ul L3 Y ok | cancel |

\Enmrbemnnmgcuﬂomenogom

Scroll up and down in the browser with the vertical scroll bar on the
right or use the Up and Down keys. Scroll horizontally with the VCR
buttons at the bottom of the browser.

Sort orders
Use sort orders to put information in a certain sequence.

For example, if you are performing a customer search, you have the
option of sorting the information according to alpha, customer, contact,
phone number or customer class. The information that you sort by
appears in the first column of the browser window.

For instance, you may only know the customer by its FACTS customer
number (i.e., C100), so you choose to search in customer order. When
you do the system rearranges information in the browser according to
customer number and the customer number shifts to the first column
position.

To select a sort order:

Click on one of the tabs at the top of the window or press the Alt key
plus the underlined letter on the tab.

Most searches default to the alpha order if it is available, but each user
can select which sort order the search defaults to when they open it.

Go To

Using the Go To field. There are three points to remember about this
option.
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1. It is not a filter or a keyword. As you enter look-up information in the
Go To field, the search program advances the highlight bar to the
first closest match. All the searchable information remains in the
browser so you can scroll up or down through the entire list.

Tip: When searching by item, customer, vendor or other record
numbers, enter the full number in the Go To field.

2. This field is case sensitive. If you entered data in the system in ALL
CAPS, enter the look-up information in ALL CAPS.

3. The Go To field relates to the sort order. This is important to
remember in searches with multiple sort orders. For instance if you're
in a Customer search with the Customer Number sort order selected,
C220 is valid Go To criteria. However, if you switch to the Contact
sort order, C220 will take you to the first contact name that starts
with C.

S Entryis Beyond the Last on File. If this message appears, try entering
the lookup information in either ALL CAPS or lower case, and make
sure the lookup information you entered corresponds to the search
order you selected.

Filters

Use filters to focus on specific information. When you enter a filter, the
search eliminates from the browser any information that doesn’t match
the filter criteria.

Filters are not case sensitive and they are not tied to the selected search
order. In other words, if you enter the keyword copper, the search looks
through all available information — including alpha, descriptions,

contacts, cities, states — and returns any entries that contain that word.
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Customizing searches with Preferences
All FACTS searches have user-definable preference settings.

L Preferences
Default Search Order oK
O Alnha
O Contact Lines Displayed |11 :I %
O Phone Column Headers...
@ Customer Current Preferences
O Class W Save As User Defaults
Filters

Class Zip Code SalespersoniTert.

Alpha Order [ [v* [v
Contact Order i~ ™ [v
Phone Order v I~ I~
Custarner Order i~ [+ v
Class Order i~ ™ [v

Setting preferences in graphical FACTS
Choose Options ?Preferences from the menu bar.

Default search orders: Use this setting to control which sort order
appears each time you open the search. If a search only offers one
search order, it is selected by default.

To set a default search order, select Options DPreferences from the menu
bar. Choose the sort order you want the search to default to each time
you open it and make sure the Save As User Defaults option is
selected. Click OK to return to the main Search window.

Filter preferences: For each search order, select the filters that you want
to appear. For instance, you may never use the Zip Code filter in the
Customer Search Phone Order tab. You can deselect this filter option so
that it doesn’t appear.

Number of lines displayed: Increase or decrease the number of lines
that appear in this search browser by using the spinner control next to
the input. Feature not available in character.

Save Current Preferences as User Defaults: Select this flag if you want
any preferences you have set to remain in effect each time you enter
this search. This flag also applies to Column Header settings.
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Editing columns for the search browser

¥ Colurnn Headers - Custormer Order

Display Choices: Current Infarmation:

Contact M Customer
Ll

SlspiTerr MHame
City, State
Contact 1
Fhone 1
Contact 2
Fhone 2
<] | Address 1
Class
<]<]| Alpha =l

# of Locked Columns |1_:I

ol | Cancel |

1. Choose the Column Header button in the Preferences window.

Select a column header in the left list box and use the right arrow
button to move it to the right box. The left box contains all the
possible column headers that can appear. The right box contains
the column headers that appear in the search browser. The order
in which column headers appear in the right box is the order in
which they appear in the browser.

3. Enter the Number of Locked Columns. This control enables you
to keep a number of columns “locked” so they are always in view
as you scroll horizontally.

Example: Set up your Customer Search Column Headers in the
following order: customer number, customer name, street address,
city, state, Zip Code, contact and phone number.

Then enter 2 in the locked columns field to lock customer number
and customer name.

Removing user preferences

You can remove all user preferences by selecting Options >Reset to
System Defaults in graphical.

S Resetting to system defaults clears any saved filters and resets all
search preferences back to the default FACTS settings.

Exporting search results

This option enables you to examine your FACTS search results in an
Excel spreadsheet, or you can export search results to a flat file so they
can be used in other programs, such as word processors, contact
managers, etc.

Users must be assigned the Export security code defined in SM
Company Control F/M to use this feature.
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To export search results to Excel:

Note: You must open the Excel program before exporting a search to
Excel.

1. Open a search.
2. Use the Go To and Filter fields to locate the information you want.

3. Once you have the desired information in the browser, select Export >To Excel.
FACTS automatically formats the results and sets up column headers.

To export search results to a flat file (ASCII):

1. Open a search.

2. Use the Go To and Filter fields to locate the information you want.

3. Once you have the desired information in the browser, select Export 2To Flat File.

4. Name the flat file. You do not have to enter the .txt extension to the file name; it will

be added automatically.

FACTS saves the flat files to ssi7\fileprt by default. To save the
file to another drive and directory, specify the path in front of the
file name.

Example: C:\ My Documents\ myflatfile.

Printing search results

You can output your search results to any FACTS printer, Windows
printer (graphical only) or to a viewer.

To print search results:
1. Use the Go To and Filter fields to get the search results you want.

2. Select the Print option from the menu bar and select one of the
printer options. If you select either the Windows (graphical only)
or the FACTS printer options, choose a printer from the dialogue
box. The viewer automatically opens when you select it.
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File Maintenances

During installation and setup, use certain file maintenance programs to
enter information into the system (such as customer, item and vendor
files). Implementation Consultants and System Administrators use
other file maintenance programs to control how FACTS processes
information and which features are available to the users.

Often called F/Ms for short, these programs can be used at any time to
modify or maintain system data.

S Keep in mind that any changes you make can deeply impact your
data and the way FACTS processes this information.

Some F/Ms, such as Customer, Item and Vendor F/Ms, allow you to
keep multiple records on file in your system. When you add a new
record, you enter a unique code, called a key. These codes are later used
throughout the system to access their respective records.

Other F/Ms, such as the Static and Nonstatic Control F/Ms, are single-
record programs. These F/Ms primarily contain controls and settings
that affect the way FACTS operates.

For instance, the Sales Order Static Control F/M contains controls and
flags that activate — or deactivate — features such as Cash Drawer
Handling, Remote Order Entry and Job Costing, to name a few.

Single-record F/Ms rarely require data entry, and FACTS
Implementation Consultants are usually responsible for setting the
controls and flags in these programs.

To add a record (in multi-record F/Ms only):

1. Enter a unique code. These are usually alphanumeric and their
lengths vary from program to program. Press Enter. When the
program asks you to verify that you want to create a new record,
choose Yes.

2. Complete the inputs. Some file maintenances contain several tabs
of inputs. As you finish entering information on one tab, the
program automatically advances you to the next one. When you
complete all the inputs, Save the entries.

To edit a record:

1. Select the record by entering its code. Select the Search button or
press F2 to lookup the code.

2. Edit the necessary inputs.
3. Save the changes.
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To delete a record:

1. Select the record by entering its code. Select the Search button or
press F2 to lookup the code.

2. Choose Delete (or press Alt+D). Choose Yes to confirm.
To browse records:

1. Inamultiple-record file maintenance, press F3 to bring up the first
record on file or enter a code.

2. Use the VCR buttons to page through records. You can also select
a VCR button and then use Ctrl+Right Arrow or Ctrl+Left Arrow
to page through each record. Use the First and Last buttons to get
to the beginning or end of a file.
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Inquiries

Inquiries are similar to searches in that they enable you to look up
information stored in the system. However, inquiries provide much
more in-depth information than searches in what are called Views.

Each inquiry program offers different view options. For instance, in the
Vendor Inquiry you can view general information for each vendor,
including contacts, status, phone numbers, etc. You can also view
activity for each vendor, open and paid invoices, notes, payment
history and ledgercards.

You may find it helpful to have inquiries open while you are working
in entry programs so you can view information as you enter invoices,
orders, purchase orders, etc. If you are entering purchase orders, for
example, it may be beneficial to have the Vendor Inquiry program open
at the same time.

Inquiry windows consist of three sections:

The inquiry browser, which enables you to select the subject of your inquiry,
such as an item, customer or account.

The view bar, in the center of the window, which lets you quickly access
different slices of information available on the subject.

The view area, where the information appears. The view area may present
display-only data or it may present a list box. In most cases, list boxes
enable you to get more detail on each line item listed. Views can also be
opened as separate windows (in graphical only). Choose Options 2Open
View as Window.

Inquiry with display-only view

Find a record with the Go
To field. Use the Starts
with filter when you are
sorting by unique IDs,
such as vendor number or
item number.

Set filters. A check
mark indicates
filters are set.

General In
2 WAREHOUSE

v Arrows on the view

Available records 7§eneral Codes Activity Qpgn Docs Faid Docs &tes ﬂ V- bar indicate more
are listed in the Phone#1 404 393-7044 TaxExempt®  KANE views are
inquiry browser. Phone#2 404 393-7045 Doc Group 01 available.

Contact1  Roger Smith 10991D# 3422-09-8887

Contact 2 Gloria Faye Ship-From SAME

Vendor Status  Permanent Ptare FastPO's  Yes
hMessage  KANEKANEKANE Uge Ledgercards  No

Use the VCR buttons to
view additional information
in the browser.

oufCustomer#  5-890-0 Activate Sync to

get real-time
inquiry information
as you work in

Select the type of The view area displays entry programs.
information you want to information for the record
look up from the view bar. and view highlighted.
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Inquiry with list box view

‘\[H -Specialty Distributors. Inc.. AP Yendor Inquiry - Yendor #f Order [APIG10)
Options Yiew SotBy Expot Print Help

GoTo | | Slarts with ErA= |!|

Vendor endor Name City, State

U188 General Industrial HMfg....... + Atlanta, GA GENERAL
U181 Industrial Supply Distributors Atlanta, GA INDUSTRI

U182 S.E. Industrial Prod. & Equip. Atlanta, GA $.E. IND~
v
ﬂ General Ledgercards Open Docs Paid Docs FPayment Hist Motes u .
/ Sort list box
Date Created Category Urgent | Subject information by cIicking

01/14/2003 General Information MUST PLACE ORDERS ON WEEKDAYS BEFOH
0140212003

on the column
headers.

Genatal Informatian N TEST

Double click to see
details on each line item

| I
or use the Line Detail StertFrom [es =] \"_ﬁ_“l“;F \ Use the horizontal

button. Oy Unepstal | Bt | scroll bar to see
additional information.

Enter characters vendor # must start with

Using inquiries
1. Look up the record on which you want to inquire with the Go To
input.

Tip

When searching by
item, customer,

In the Vendor Inquiry, for example, enter a vendor number, alpha vendor or other

lookup or beginning characters of a vendor’s name. record numbers,
enter the full

You do not need to press the Enter key to select your inquiry focus. Just number in the
highlight the desired line item. Some inquiries offer multiple sort ERD DI
orders, which can be accessed from the Sort By menu option.

Using the Go To field.

1. It is not a filter or a keyword. As you enter look-up information in the
Go To field, the search program advances the highlight bar to the first
closest match. All the searchable information remains in the browser so
you can scroll up or down through the entire list.

2. This field is case sensitive. If you entered data in the system in ALL
CAPS, enter the look-up information in ALL CAPS.

3. The Go To field relates to the sort order. This is important to
remember in searches with multiple sort orders. For instance if you're
in a Customer search with the Customer Number sort order selected,
C220 is valid Go To criteria. However, if you switch to the Contact sort
order, C220 will take you to the first contact name that starts with C.

S  Entryis Beyond the Last on File. If this message appears, try entering
the lookup information in either ALL CAPS or lower case, and make
sure the lookup information you entered corresponds to the search
order you selected.

Press CTRL + €or = or the horizontal scroll bar to scroll horizontally
to view additional inquiry browser record information.

2. Select an inquiry view.

To select a view, press Shift + - and Shift + € to change the view to
the left or right. You can also choose a view option from the view bar
by using the << (left) and << (right) arrow keys on the screen or select
View from the menu bar and select a view from the dropdown menu. If
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line detail is available, select a line and choose the Line Detail button or
double click the icon at the beginning of the line.
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Sorting in list views

Some views, such as open or past document views, can contain large
lists of records that may take a long time to load.

The System Administrator or FACTS Affiliate determines how many
documents the browser should list at a time.

To help sort through these lists quickly:

Enter a specific record to view in the Starts From field.

Select the Ml button to return to the top of the list.

Select the * button to load the next group of records into the browser.
Interrupting the file load in a list view:

Click on the Interrupt Load box to start viewing records in the browser.
Select the *! to load the rest of the records.

Inquiry menu options and other features

View menu

Use the View menu to select different inquiry views or select the Notes
Entry feature (see “Entering notes in inquiries”).

Sort by menu (if available)

Some inquiries allow you to sort records in different order. For instance
the Vendor Inquiry enables you to sort vendor records by vendor
number, vendor alpha lookup or vendor name.

Use the Sort by menu to select a sort order.

Options menu

The Options menu allows you to

e Set filter values

e Save filter values

e Set inquiry preferences

e Reset preferences and filters to system defaults
e Set view preferences

e Open views as separate windows
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Setting filter values
Use filters to help you refine your search for a record.

Choose Options 2Filter Values from the menu bar or click the Filter
button at the top of the screen.

\ Filter Selections

Inquiries provide two |
keyword filters. !

Keywords |

Press the operator

button to toggle 5 |

between and and or. Slsp/Terr | |

Use and to search for R B S
records containing both - ] =
key words. /fﬁter keyword 1

The other filters available
to you change depending
on the inquiry.

Press OK to accept the filters entered.
Press Clear to remove any existing filters.
Press Cancel to exit the Filter Values window without saving changes.

To save filters for future use choose Options >Save Filter Values from
the menu bar.

< Filter values are specific to each user. Any filters you save will be
available to you, but not other users on the system.

CUl Version

\Cuslume[ Inquiry [SO1610) |_ O] ]
Help
B1-Specialty Distributors, InS0 Customer Inquiry - Customer Order S0I618
Hold Customer Hame Cit State Zip Code
8 BARRINGTOH FARHS GASPORT, HY 15115
9 Winfield Industries, Inc. Buffalo, HY 14215
Go To Starts With Filters Off
Sync OFF
—Filter Selections e
Starts With | -3
— |Keyuwords or —
1]
Ho |Class
Slsp/Terr

View Filters:81/SHU

Enter characters customer must start with, F1-Clear, Fi-Backup
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Setting inquiry preferences

Inquiry preferences are similar to search preferences. This function lets
you personalize certain inquiry functions to meet your day-to-day

needs.

Choose Options BInquiry Preferences from the menu bar to access

preferences.

Choose the sort order
that you want selected
each time you enter the
inquiry.

rDefault Search Order
) Alpha
O Contact
@ vendor Number

Check the current

Cancel |
Column Headers... |

Select Column

Current Preference
[V Save As Usar Defaults

Headers to
‘ customize the

preferences flag to

save settings as your Filter

inquiry browser.

user defaults.
Alpha Order:

Contact Order:
Wendar Mumber Order:

Choose which filters
you want to appear in

Class
|7
[~
v

the Filters window.

Column headers
. ¥ Colurmn Hea

Move header titles from the
Display Choices list box to
the Current Information with
the arrow buttons in the
middle of the screen. The
double arrows move all titles
at once. You can also double
click a title to move it from
one box to another.

Display Choices:

Yendor Mame

City, State
Contact 1

Lock columns so they
remain visible when you

‘endor Mumber Order

4

==

Columns appear in
the inquiry browser in
the order that they
appear in the Current

Information list box.

scroll horizontally. In this
case Vendor will remain
visible as you scroll through

#ottocked Columns: [T =

ok | cancer |

the other columns.

To reset preferences and filters to the system defaults, choose

Options DReset to System Defaults.
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Setting view preferences

Inquiries such as Item Inquiry include close to 25 views. Use view
preferences to quickly access the views you use most and hide the
views you don't use at all. View preferences are specific to each user.

To quickly access a view
you use most often,
choose the view in the list
box and select Favorite.

Select an Inquiry View and set its
attributes on the right.

The views you set as
favorites appear at the top
of the view menu and the
beginning of the view bar
in the order you select
them. Click OK.

Paid Docs
Motes
Payment Hist
Ledgercards

L View Preferences
T.O hide a view fr(.)m the Select an Inquiry View and set its
view me'm'J and Y'eW bar, attributes on the right.
choose it in the list box
and select Hide.

Click OK.

General

[~ Favorite

Paid Docs

Ok Cancel

Smart Views. When this feature is turned on, FACTS tracks which
views you use most and places them at the top of the view menu and
the beginning of the view bar.

The system determines your favorite views by tracking how many
times you hit (or select) a view.

Tip: You must be in a view for at least five seconds for it to count as a
hit. That prevents FACTS from mistaking views that you quickly flip
through as favorites.

When Smart Views are on, FACTS prioritizes your favorites in the
following order:

1. Views you marked as favorites in the View Preferences window.
2. Number of Smart View hits in descending order.

3. The view order set in the SMVIEW Developer’s Tool by your
Affiliate or System Administrator.

To use Smart Views:

Choose Options 2Smart Views to use this feature. Select it again to turn
it off.

Choose Options 2Reset Smart Views to remove any usage information
the system has stored.

The Sync feature and Open Views as Windows

Sync is a method of connecting the entry programs with information
displayed in customer, item and vendor inquiries. It is a helpful feature
because it enables you to get real-time information such as customer
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balances, vendor balances and warehouse quantities, while you are
working in entry programs.

You can initiate Sync from the following programs:

e SO Customer Inquiry (SOI1610)
e AP Vendor Inquiry (API610)

e AR Customer Inquiry (ARI610)
e ICItem Inquiry (ICI610)

< Inquiries are synchronized on a per user basis. In other words, if
you are signed on to FACTS in one window with one name and signed
on in another window with another name, it will appear as if the Sync
function is not working.
To use Sync:
1. Open the inquiry and entry programs you want to use.
2. In the inquiry window, press the Sync button.
3. At this point you can choose to view information from the main
inquiry window, or you can open views as separate windows.
To open a view as a separate window, first select it and then choose

Options 2Open View as Separate Window. To open additional view,
repeat these steps.

4. Minimize the main inquiry window and, if necessary, arrange the
separate view windows on your screen. (The next time you open
this inquiry, FACTS will open the same views in the same position
in which you placed them.)

To turn off the Sync feature press the End Sync button.

Technical note

While Sync mode is activated, the inquiry program will examine a file
called SMUSED approximately every three seconds. This file contains
the last customer number, item number and vendor number input in
Sales Order Entry. If this number is different than the one currently
being displayed in the inquiry, the inquiry will change its display to
show information on this new customer, item or vendor.

Entering notes in inquiries

Notes are useful for documenting miscellaneous information about each vendor, item,
customer document, or account used in FACTS.

For Item Inquiry (ICI610), AP Vendor Inquiry (ARI610), PO Vendor Inquiry (POI610),
or Customer Inquiry (ARI610), select Options—>Item Note Entry, Vendor Note Entry, or
Customer Note Entry respectively to enter or modify notes for the specified item, vendor,
or customer in the Note Entry (SME710) program.

1.  Access the Notes Entry window in Inquires.

Graphical users: Choose View ?Notes from the menu bar.
Character users: Type !, press F1 and select Notes Entry.

Any notes on file for the selected record will appear in the Notes
window. If no notes exist, the system asks Enter notes for this
[record]?
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2. Enter Y to begin entering notes.

You can enter up to 70 characters on each line and up to 99 lines for
each record (assuming the lines are incremented by 10).

Start a new line by pressing the Enter key.

Press F3 when you are finished entering notes.

Once notes have been added, or if notes already exist, the following
options are available:

# Line number to change. Notes may be changed or deleted by entering the
line number. Enter whether to Change or Delete. If D is entered, the line is
deleted. If C is entered, enter text (up to 70 characters). During this change
routine, F1 defaults to the currently displayed value of the input. F3 ends
entry of lines. F4 backs up to the line number; enter the new line number. If
a new line number is added, the old line number is deleted. F2 allows you to
change the number increments (1-10). F4 backs up to the main input.

L Lists line numbers. A limited number of line-numbers appear on the screen
at any time. The list function allows line-numbers to be redisplayed. Enter
the beginning line number to list.

A Adds aline number. New line numbers may be added as needed. F3 ends
entry of lines. F4 backs up to the line number, enter the new line number. F2
allows the user to set the line number increment (1-10). F4 (from line
number) will back up and delete the previous line.

M Moves a line number. Enter beginning line number to move. Enter ending
line number to move. Enter line number where text will be moved (existing
lines will be replaced). One line at a time or blocks of lines may be moved.

D Deletes a line number. One line or several lines of notes can be deleted at
any one time. Enter beginning and ending line numbers to delete. Enter N
or YES to delete. CR defaults to N.

F4 Exits the Notes Entry window.
Refer to the How to enter and maintain notes for AR documents, transfer tickets,
customers, items, or vendors and the Note Entry (SME710) topics in Chapter 5, Security
System of the System Management Users Guide for step-by-step instructions on using the
Notes system in FACTS.
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Using the Notes System in FACTS

Use Note Entry (SME710) to enter and maintain notes for AR
documents, customers, items, IC transfer tickets (header and lines), and
vendors.

You can also access notes directly from the main screen of programs
that use the 3-Level Entry Driver instead of requiring a menu option.
The programs include: Transfer Entry (ICE320), Shipment
Confirmation (ICE 330), Receipt Confirmation (ICE340), SO Quote
Entry (SOE110), Order Entry (SOE210), Order Confirmation (SOE310),
Direct Invoice Entry (SOE510), Credit Memo Entry (SOE330), Counter
Sales Entry (SOE510), PO Entry (POE120), PO Receipt Entry (POE210),
and Non-PO Receipt Entry (POE220). On the left side of the line item
browser, you can select:

C.. to access Note Entry (SME710) for the customer specified in the
program.
L to access Note Entry (SME710) for the item highlighted in line item

browser.

V.. to access Note Entry (SME710) for the vendor specified in the
program.

D/ to access Note Entry (SME710) for the transfer header record
specified in the program.

L. to access Note Entry (SME710) for the transfer line record
highlighted in the line item browser.

Refer to the How to enter and maintain notes for AR documents, transfer
tickets, customers, items, or vendors and the Note Entry (SME710) topics in
Chapter 5, Security System of the System Management Users Guide for
step-by-step instructions on using the Notes system in FACTS.

Copyright © 1984-2005 Infor, Inc 1-31



Reports, Registers and Prints

There are three types of reporting programs in FACTS.

Report programs print information in a specific format, but they do not
update the system. An example is the Open Receivables Report, which
lists all the open receivables in the system along with other information

Print programs output to forms, such as checks, 1099s, invoices,
purchase orders, bills of lading, etc.

FACTS Report Formatter

The Report Formatter brings more flexibility, convenience and
functionality to FACTS reports by allowing you to customize changes
to FACTS report output without the modification of standard code.
FACTS Report Formatter allows you to expand their report output
options in a variety of ways to further enhance the way they gather
information from FACTS.

The Multiple Output option also allows you to print to more than one
output for each instance of a report. For example, a report can print to
Excel, the viewer, and to a printer all in one print run. To access the
multiple output feature simply choose the Multiple option from the
Print Options screen.

The FACTS Report Formatter also supports supply chain management
needs by providing report output to XML. You can print directly to a
TCP/IP port or to a file with customized XML tags for each supply
chain partner.

Those reports that use the Report Formatter can take advantage of new
output types. Properly configured, you can print reports to:

Excel

XML (Can print to TCP/IP port)

ASCII Delimited (Can print to TCP/IP port)

Other (Programmer defined)

HTML to a file

You can manage security concerns for the Report Formatter by placing
a security code on any field to prevent it from printing on the report for
unauthorized users.

GUI/CUI Users: The FACTS Report Formatter is only available in
Graphical mode. However, Character system users can access the
Multiple Output option and custom templates and outputs that have
been created by graphical users. However, if the template specifies an
output that a character user cannot access, like Excel, the report will not
run propetly.

FACTS Report Registers

.Registers print information and then provide an optional update,
which posts the register information to the appropriate files. For
example, after invoices are printed, they print on the SO Daily Sales
Register. If you update the register, the invoices then post to the open
receivables file, sales tax file, etc.
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Most report, print and register programs allow you to
Select the order in which you want the information to print,
Set a range of information to print and
Edit properties, which vary with each report.

For example, the AR reports give you the option of printing in
customer number, alphabetical, salesperson/ territory or customer class
order. If you choose to print a Customer Listing in customer class order,
the report will sort and print all of the customers by class.

Once you select an order you can then choose the beginning and
ending record that you want to print. The system always defaults to
FIRST and LAST. These two fields enable you to filter your report by
entering ranges.

In the Customer Listing example, you could enter Retail for beginning
class order and Retail for ending class order to generate a report listing
just your retail customers.

In addition to order and range, all reports and prints have a variety of
properties that enable you to fine tune your reports.

Once you have answered all the questions in the report, click OK or
press CR.

Most FACTS reports print in 132-column paper (11 %2 x 14 inch paper).
However, some reports, such as the Chart of Accounts, print on 80-
column paper (8 2 x 11 inch paper).

The END OF INPUTS statement indicates where 80-column paper may
be used.

The following information appears on each page of all reports, except
GL financial reports:

*  the time and date the report was printed

*  the user

*  the terminal from which the report was run
*  company name

*  report name

*  program name

*  page numbers

*  sort order

*  beginning and ending range
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Using print options

On each report, you can select the type of output device to which the
report should print, select or deselect beginning and ending form feeds
and adjust the number of lines in the top and bottom margins.

Print options can be set each time you run the report by selecting Print
Options >Properties.

To save time, you can also save print options in templates. For instance,
you can create one template so a report outputs to a printer, create
another template so the same report outputs to a Fax and then create a
third template so the report outputs to the viewer so you can preview it

on screen.

1tem Iype B

Uendor Print Options

Item Descr — Print To

Warehouse | Print to U Uiewer

Activity Printer

Ualuation File

Include Ze

Include He| No. Copies 2 Layout 3 danna‘s layout

Serial/Lot| — Margin Settings
Top Hargin a Bottom HMargin 9
Begin form feed Y End form feed VY

— Template ———— - Printer ———  — — Layout
Hone WindX Laser Standard

CR-0K, F1-Hultiple, F2-Edit, F4-Cancel

y

)\ Print Options El
Ptint To
Printto  |FAEET -
Printar D WindX Laser
File
Mo. Copies 1 Layout - Standard -

Margin Settings
Top Margin - Bottom Margin a9 -

End form feed

Qe

Begin farm feed

[ ok ][ mutipe ][ cancel

Selectwhere to print the report

A |

Hote Type  SOQH Quote Document Header Note
Quote# 000855

PrintTo
Prntto  ERZETEEN ~|
Printer M

File |

Margin Settings

Lines margin |9 =

W Begin reportwith a formfeed W End repart with a form feed

oK cancel

Selectwhere to print the report
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Inputs
1. Print to OPTION

In FACTS, you can output reports to a printer, viewer, flat file or you
can output to other software packages, such as VSI-Fax or Archive.

Printer gives you access to any of the FACTS printers set up in Printer
F/M. In graphical, select the printer from the dropdown list. In
character, continue to the Printer/File field and press F2 to search the
list of available printers.

Viewer enables you to review a report on screen. Both the graphical
and character viewers have search and scrolling capabilities. The
graphical viewer is also equipped with print capabilities, as well as a
clipboard feature.

File lets you print the report to a flat file format. This enables you to
import report information into other software programs such as
spreadsheets, databases, word processors. You can also attach the flat
files to e-mail messages. FACTS automatically saves flat files to a folder
called fileprt. To save the file somewhere else, preface the name of the
file with a directory path. For example, C:\ My

Documents\ agedtriall.txt.

Fax sends the report information to VSI-FAX, giving you desktop
faxing capabilities. This option is only available on systems using the
Faxlink module. If you have questions about this feature, contact your
local FACTS Affiliate.

Archive is only available on systems using Archive™ software by
Designed Data Systems, Inc. This is an on-line storage and retrieval
system that lets you automatically build a library of important
documents.

For reports with multiple output options, the system also displays any
custom templates and outputs created using the FACTS Reports
formatter.

2. No. Copies

Enter the number of copies to print of the report. You can specify the
number of copies for any output except fax, email and Archive.

3. Layout

From the personal custom layouts and system layouts that are
available. Custom Layouts can be chosen when the report is run from
the Print Options or the Multiple Output Selection and can be saved
into Templates.

Margin Settings
4. Top Margin

Enter the number of lines in the top margin. All FACTS forms print 53
lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.
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5. Bottom Margin

Enter the number of lines in the bottom margin. All FACTS forms print
53 lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Begin with form feed

Indicates to the system that you want to print a blank form at the
beginning of reports.

6. End with form feed

Indicates to the system that you want to print a blank form at the end of
reports.

7. Multiple option

Use the Multiple option to display the Multiple Output Selection
screen. For each output, you can choose the type of output and any
applicable information, like Printer Number, File Name, Number of

Copies, Standard or Custom Layout (see Custom Layouts below), and
margin and form feed preferences.

CUI users, press F1 to use the Multiple option to display the Multiple
Output Selection screen.
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Multiple Output Selection Screen

Use the Multiple Output Selection Screen to choose the type of output
and enter any applicable information, like Printer Number, File Name,
Number of Copies, Standard or Custom Layout (see Custom Layouts
below), and margin and form feed preferences for each output you
select.

When you select the Multiple option on the Print Options screen, the
system displays the selected Print To option information as the default
in the upper portion of the screen.

Note: If a FACTS report program is configured to use the FACTS
Report Formatter and more than one print or output option exists for
the report, the system displays the Multiple Output Selection screen
instead of the Print Options screen.

T Stock Status Report (ICR710] = E3
Help

B1-FACTS 7.4 Maintenance Hultiple Output Selection SMR997]
Print to U Uiewer

Printer

File

Ho. Copies @2 Layout 3 danna's layout

Top Hargin a Bottom HMargin 9

Begin form feed Y End form feed ¥

Ln#t  Print To Printer/0utput Code File/TCPIP Copies
881 Viewer 2

add

Cancel
CR-Edit, DEL, F3-

, Pgbn, Home, End First line

‘\ 01-FACTS 7.4 Maintenance, Multiple Qutput Selection (SMR997)

Help
Frintto
Frinter |
File |
Mo, Copies Layout
Top Margin Bottorm Margin
Ln# | Print Ta Frinte’Output Code File/TCFIP Copies
001 Printer WindX Lazer 3
002 Excel 1
o0z Wiewer 1

Cancel ][ Done
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Inputs for Multiple Output Selection
To modify this information, highlight the Print to option in the browser

in the lower portion of the screen and select the [# icon (CUI users

press Enter). To add a new output selection for the report, select the +
icon (CUI users select Add).

Print to OPTION

In FACTS, you can output reports to a printer, viewer, flat file or you
can output to other software packages, such as VSI-Fax or Archive.

Printer gives you access to any of the FACTS printers set up in Printer
F/M. In graphical, select the printer from the dropdown list. In
character, continue to the Printer/File field and press F2 to search the
list of available printers.

Viewer enables you to review a report on screen. Both the graphical
and character viewers have search and scrolling capabilities. The
graphical viewer is also equipped with print capabilities, as well as a
clipboard feature.

File lets you print the report to a flat file format. This enables you to
import report information into other software programs such as
spreadsheets, databases, word processors. You can also attach the flat
files to e-mail messages. FACTS automatically saves flat files to a folder
called fileprt. To save the file somewhere else, preface the name of the
file with a directory path. For example, C:\My

Documents\ agedtriall.txt.

Fax sends the report information to VSI-FAX, giving you desktop
faxing capabilities. This option is only available on systems using the
Faxlink module. If you have questions about this feature, contact your
local FACTS Affiliate.

Archive is only available on systems using Archive™ software by
Designed Data Systems, Inc. This is an on-line storage and retrieval
system that lets you automatically build a library of important
documents.

For reports with multiple output options, the system also displays any
custom templates and outputs created using the FACTS Reports
formatter.

2. No. Copies

Enter the number of copies to print of the report. You can specify the
number of copies for any output except fax, email and Archive.

3. Layout

From the personal custom layouts and system layouts that are
available. Custom Layouts can be chosen when the report is run from

the Print Options or the Multiple Output Selection and can be saved
into Templates.
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Margin Settings
4. Top Margin

Enter the number of lines in the top margin. All FACTS forms print 53
lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Bottom Margin

Enter the number of lines in the bottom margin. All FACTS forms print
53 lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Begin with form feed

Indicates to the system that you want to print a blank form at the
beginning of reports.

6. End with form feed

Indicates to the system that you want to print a blank form at the end of
reports.

7. Multiple option

Use the Multiple option to display the Multiple Output Selection
screen. For each output, you can choose the type of output and any
applicable information, like Printer Number, File Name, Number of
Copies, Standard or Custom Layout (see Custom Layouts below), and
margin and form feed preferences.

CUI users, press F1 to use the Multiple option to display the Multiple
Output Selection screen.

In the browser in the lower portion of the field, the system displays any
existing or newly added Print To/ Ot;‘gout options. You can highlight a
Print To/Output line and select the ¥ ion or the Delete key to delete it.
When you have finished adding/editing/ deleting outputs for the

report, press the lml icon to save your changes and the Done button to
return to the report (CUI users press F3). Press the Cancel button or C
to exit without saving your changes.

Tip: Outputs Defined

The difference between a printer (defined in Printer F/M) and an
output option (as defined in the new Output Options F/M) is that
output options have expanded functionality. Advantages are:

Printing to new output types

When creating a report as a file, an administrator can control file output
to always be placed on the client PC or always on the server
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When creating a report as a file, an administrator can control what the
filename will be with run-time replacements (see below for an
explanation of what these are).

Output can be customized with open, close, post-open, pre-close, and
post close procedures.

Regular printers (printers set up in Printer F/M) can still be used.
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Customize Report (SMR999.U)

Use the Customize Report program to associate formats, custom
layouts, xml tags and tiers to reports. You can access the Customize
Report program from Custom Report Layout menu.

Custom Layouts can be chosen when the report is run from the Print
Options or the Multiple Output Selection and can be saved into
Templates.

)\ 01-FACTS 7.4 Maintenance, Customize Report (SMR%99.U)

File Help
Prograrm
Format Stock Status
Layout danna's layout
Description Max Width
Report XML Tag Format XML Tag
Tier 0101 Item
X
Suppress Printing 5e Default Totals Only | ©- Use Default v n
Beg of Tier | o. Use Default = Endofling | o.uUseDefault  w| ENQOTTIEr |D.Use Default  w
Print Count | D- Use Default  w Print Column Headers at Top | D- Use Default  w
Tier XML Tag | tem_tier Line XML Tag | item

Description Wariahle Tier XML Tag

icmast.item_num$

Suppress printing this tier? (DN

Inputs for customizing reports

The system displays the report program name at the top of the screen
as the default.

1. Format

Select a format to associate with the customized report. For each
format, users can create a custom layout (a format is a way that the
report is run, like a sort order, or summary vs. detail). It's important to
note what report elements make up a format for that report. For
instance, if you customize the Customer Listing’s General Info format,
those changes will not apply to the Customer Listing’s History format.

2. Layout
Enter a layout to use to customize the report. To create a new layout,

select the # icon. To search for an existing layout, select the # icon.
To copy an existing layout, select the & icon and the select a layout to

copy.

3. Description

Enter a description of the report layout.
4. System Layout

Indicate whether you want this report layout to be available as a system
layout.
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5. Max Width

Enter the maximum width in columns for the report layout.

6. Report XML Tag

Enter the XML tag for the report. (This is particularly useful for supply
chain management needs.)

7. Format XML Tag

Enter the XML tag for the report format. The report format XML tag

allows to print directly to a TCP/IP port or to a file with customized
XML tags for each supply chain partner.

Tier Section

Each format contains tiers — the different groupings that contain data
elements on the report. You can edit the tiers by highlight a tier in the line

item browser in the lower portion of the screen and pressing the E; icon.
You can edit the following inputs for each tier:

8. Suppress Printing:
Use the dropdown list to indicate how to suppress printing. You can
select from:

D-Use Default— None of the tier’s fields will be printed, but the records
will be processed. Sub-tiers will not be suppressed.

Y-Yes —Suppress Printing.

N-No — Print This Tier

9. Totals Only

Use the dropdown list to indicate how to print totals. You can select
from:

D-Use Default— Print only a total line for each tier.

Y-Yes.

N-No

10. Beginning of Tier:

Use the dropdown list to choose spacing preferences for the beginning
of the tier. You can select from:

D-Use Default.

N-Nothing

1—1 Line Feed

2—2 Line Feeds

3—3 Line Feeds
P—Page Break

11. End of Line:

Use the dropdown list to choose spacing preferences for after each line.
You can select from:

D-Use Default.

N-Suppress LF
L—Line Feed
1—1 Blank Line
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2 —2 Blank Lines
P —Page Break

12. End of Tier:

Use the dropdown list to choose spacing preferences for the end of the
tier. You can select from:

D-Use Default.

N-Nothing

1—1 Line Feed

2—2 Line Feeds

3—3 Line Feeds
P —Page Break

13. Print Count

Use the dropdown list to choose print count settings. You can select

from:

D-Use Default

Y-Yes.

N-No

14. Print Column Headers at Top:

Use the dropdown list to choose print settings for column headers at
the top of the page. You can select from:

D-Use Default

Y-Yes. —The headers print at the top of the page.

N-No —The headers print at the top of the tier.

15. Tier XML Tag;

Enter the Tier XML tag according to the requirements of your supply
chain partner, if applicable.

16. Line XML Tag

Enter the Line XML tag according to the requirements of your supply
chain partner, if applicable.

Note that the % icon is disabled. You cannot remove a tier from a customized report.
Press the Layout button to access the FACTS Report Designer, where you can change the
layout for each tier

Press the Security button to access the Security Entry Screen (SMR999.S), where you can
manage security for each field on the report layout. .
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FACTS Report Designer
Use the FACTS Report Designer to create Custom Report Layouts. You
can customize each report layout in many ways:
¢ Remove a field from the report
e Add anew field to the report
e Change column header titles
e Change which columns get totaled
¢ Change the width of fields and their header titles
e Change XML tags on a field-by-field basis for each layout

“\ FACTS Report Designer &‘

File

Report: Stock Status Report Format: Stock Status Tier: ttem

[PESCRIPTION-1 EEE 0N ORDER irCOMMITTED  BACKORDERED [Jur]

Eost Bl Extension

Max Width=132

insufficient qty flag: Golumn=80,Rou=1Wiidth=1

Once you create your own layout, you can name the layout and save it
for easy access in the future. The layout can be a Personal or System
layout and if desired, can be set as a user’s default layout. Report
templates will indicate which layout you prefer.

To access this screen press the Layout button on the Customize Report
(SMR999.U) screen. The system displays the report name, report
format and tier at the top of the screen as the default.

You can:
Drag and drop fields —you can rearrange the fields in each tier.

Hide fields —you can suppress fields from the report by right clicking
on the field and clicking Hide.

Add fields —you can add fields by right clicking on a blank area and
choosing the Select Field to Place Here option. The system displays the
Place Information Field Search screen where you can choose a field to
add to the report:

Note: Most fields from the files that relate to the report will be
available. For instance, the Customer Report can be modified to add
almost any Customer File or Ship-To field.

Edit fields —you can edit fields by right clicking on the field and
choosing Edit to display the Edit Field Attributes screen.
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Edit Field Attributes screen

Use the Edit Field Attributes screen to edit the fields in a custom report layout in the
FACTS Report Formatter feature.
The system displays the report program name, report format, and reporting

information (such as the extension) at the top of the screen as the default.

Stock Status Report
Stock Status
Extension - {i#00107 pos(x0$(1,1)="5"),i#00618,1)}i#00619)
Genaral
Frint Width 1] Frinton Continued Line | b - Use Default

H¥MLTag | extension

Totaled  |o- use Default hd Total Only | D Use Default  »
Total Type |0 - Use Default  w Rounding | D- Use Default -
Parens for Med |p- Use Default Comma for Thousands Separator | p. Use Default  »

Column Header | "Extension”

Header Width 11 Justification | D- Use Default =

OK ] [ Cancel

Enter the number of characters wide to print

Inputs for customizing reports
1. Print Width
Enter the number of character wide to print for the field. You can

change the width to your preference, keeping in mind that it is possible
to truncate the data.

2. Print on Continued Line

Use the dropdown list to indicate whether to print this field when
continuing on a new page. You can select from:

D-Use Default

Y-Yes

N-No

3. XML Tag

Enter the XML tag for this field according to the requirements of your
supply chain partner, if applicable.

For numeric fields, choose from the following:

4. Totaled

Indicate whether this field should be totaled. You can select from
D-Use Default--Totaled:
N-No--Not totaled

1- Total at this level only (for example, on the Stock Status report, total
the serial/lot costs after each item)

2-Total at this and all previous levels (for example, total the serial/lot
costs after each item and then also at the warehouse level)
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3- Total at the top level only (for example, don’t total the serial/lot costs
at the item level, but do give a warehouse total for serial/lot costs)

5. Total Only

Use the dropdown list to indicate whether this field is only printed as a
total. You can select from:

D-Use Default

Y-Yes--The field on each line will not print, but a total will print after all
lines are printed.

N-No

6. Total Type

Use the dropdown list to indicate the type of total for this field. You
can select from:

D-Use Default

S-Sum,

A-Average,

M-Min,

X-Max, or

O-Count

7. Rounding:

Use the dropdown list to enter the appropriate rounding rule. You can
select from:

D-Use Default,

B-Round the field amount before adding to total, or

A -Round after all fields have been added to the total.

8. Parens for Negative

Use the dropdown list to indicate whether to parans (parenthesis)

instead of a minus (-) sigh when numbers are negative. You can select
from:

D-Use Default

Y-Yes --if you want negative numbers for this field to be expressed in
parentheses.

N-No--if you want them to be expressed with a negative sign (-).

9. Comma for Thousands Separator

Use the dropdown list to indicate if you would like commas to separate
thousands. You can select from:

D-Use Default

Y-Yes

N-No

10. Column Header

Enter the text of the header column.

1-46 Copyright © 1984-2005 Infor, Inc.



11. Header Width

Enter the width of the header text. If the text of the header is wider that
the text of the column header, the text will wrap to accommodate the
width.

12. Justification

Enter the justification of the report. You can select from:
D-Use Default

L-Left,

R-Right,

C-Center

Select File=>Save to save your customized report layout, or select File=>Exit to exit the
screen without saving your layout.
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Viewing reporis on screen

Both character and graphical interfaces provide viewers that enable you

to review report information on your terminal or screen. Viewers help

you control paper by allowing you to preview a document before you

print it.

Starting the viewer. Make sure you select viewer in Print Options >Properties or the
template selected prints to the viewer. Run the report and click OK when the
program pops a dialogue box that says End of Report.

Once you click OK, the viewer automatically opens.

= Opens another document in the viewer.
Saves the document as a report file.
& Saves the document as a PDF file.
& Printing from the viewer. Click the Printer button in

the menu bar or select File 2Print from the menu.
Select a printer and number of copies from the Print
dialogue box.

P Using the Find feature. To locate a specific date,
description or other piece of information in a report,
click the Find button or select Edit ?Find from the
menu bar.

View single page format.

oo View the report in a 2 pages-per-viewing-area format.

m View the report in a 2 pages-per-viewing-area in a
book-style format.

R View the report in a 4 pages-per-viewing-area format.

B Fit the report to the page width of the viewing screen.

Fit the report page to the window.

Fes[ 1 @) zeefix -] @ Magnifying the report. If the type appears too small
on the screen, click the plus button or select
View->Zoom In. To reduce magnification, keep
clicking the minus button or select View=>Zoom Out.
You can also enter any Zoom percentage from 1 to
400%. You can also enter a specific page number in
the Page input located in the menu bar

@ View Banner Information--file properties, such as title,
file name, user name, and creation date.

To exit the graphical view, select File 2Exit from the menu bar.

FYI

The vertical scroll
bar in the graphical
viewer enables you
to move the selected
page up and down
within the window. It
does not allow you
to scroll through the
entire document.

Use the VCR
buttons or the Page
input to navigate
through the
document.
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Using report templates

The template feature allows you to save a combination of entries so that
you don’t have to reselect them every time you run the report. Each
user can create an unlimited number of templates in any FACTS report.

Once you create templates, you can edit them, delete them or change
their properties.

In the Template Properties window, you can change the name of a
template, set it as your default template for that report, set up a default
printer for that template, select or deselect beginning and ending form
feeds and modify report margins.

The system remembers the last nine templates used and displays them
at the bottom of the Templates menu for faster access.

Both user-specific and system templates are specific to the report in
which they are created.

Creating user-specific templates

1. On the main screen, set up the report order, range and properties.
Select a printer by choosing Print Options, if necessary.

Select Templates >Create from the menu bar.

3. Name the template. Template names can be up to 35 characters
long. Make sure the System Template option is not selected. Click
OK.

Creating system templates

Follow the same steps for creating user-specific templates, but select the
System Template option.

System templates are available to any user that has access to the report
in which it is created; however not all users can create system
templates. Users must have the security rights to perform this function.

Affiliates: To set security rights, refer to the Template Security field in
SM Company Control F/M and the Security Codes field in User Code
F/M.
Selecting existing templates

1. Select Template ?Select from the menu bar.

2. In the Report Templates window, select the template you want to
use.

3. Click OK. The name of the template appears on the bottom of the
main report screen so you know which template is in effect.

Setting a default template

You can set template properties so that one template is selected every
time you open a particular report.

1. Select Template PProperties from the menu bar.

2. In the Template Properties window, select the Set as Default
Template option.

3. Click Save.
Setting a default printer using templates

1. Choose Print Options >Properties from the menu.
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2. Select the printer you want to use as your default and click OK.

3. Choose Template >Create if you want to create a new template, or if
you have a template selected, choose Template >Save Entries.

Deleting a template
1. Choose Template >Properties.

2. Select the template from the list box in the Report Templates
window and click Delete.

Clearing a template
This feature enables you to reset a template back the report’s original default values.

When you clear templates, None appears under the Template header at the bottom of the
window, indicating that a template is not selected.

1. Select Template >Clear.
Once you clear a template:

¢ You can select it again (Templates PSelect) and reset the order, range
properties and printer, or

¢ You can delete it.
Changing a template name

1. With the template selected, select Template 2Properties from the
menu bar.

2. In the Properties window, type the new template name.
3. Click OK.

Editing the order, range and properties stored in templates

1. Select the template if it’s not selected already.

2. Change the order, range or properties on the main screen.

3. Select Templates 2Save Entries from the menu bar.

4. A dialog box will appear confirming the changes. Click OK to

return to the main screen.
Setting printer properties in templates

Each template can have its own printer properties so that you don’t
have to set them each time you print the report. However, you can
override the template print options on a print-by-print basis by
selecting Printer Options from the main report window.

1. With the template selected, choose Templates >Properties from the
menu bar.

2. Set the print options in the lower portion of the window.

3. Click OK to return to the main report window.

Using reports, registers and prints as audit trails

Once you run a register in FACTS, the information updated by that
register is no longer available in the system in that format.

An example is the AR Cash Receipts & Adjustment Register. Payments
are posted in the AR Cash Receipts & Adjustments Entry program. The
register provides an audit trail of the payments, discounts, adjustments
and miscellaneous cash posted. The register has a number assigned to

it. FACTS updates these numbers by one each time you run the register.
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Once this register runs, the information it has collected is written to
various programs within the system.

This is why all FACTS registers allow you to print a hardcopy before
you run them. The hardcopy gives you the opportunity to review the
data, catch any errors and fix the mistakes before they update registers.

They also serve as audit trails that can be used to help reconcile data
later on in the fiscal cycle, and they provide an additional source of
backup in case you lose register information.

How long you save these printouts depends your company’s needs. We
recommend that you save them in numerical order and by register

type.
General Register Format

Registers are similar to reports, with one significant difference. Where a
report only prints information, a register prints the information and
then optionally updates it to the appropriate files in the system.

Registers are found on the menu where the information was entered.
For example, in AP, documents (invoices) are entered through the
Document Entry Program on the document entry menu, and will
update a document entry file. Users then print the Document Entry &
Adjustments Register (also found on the document entry menu) which
will provide an audit trail of what documents were entered. After the
register is printed, it should be verified and if all the information is
correct it may be updated. The update posts the documents entered to
the open payables file.

Register procedures

1. Set the appropriate order, range and parameters and print the
register.

2. Review the register print-out and verify that the information is
correct before you update. If you find errors, return to the
appropriate entry or adjustment program to make the corrections.

3. If the module is set to print GL distributions, print and review the
GL distribution to make sure transactions balance. Make any
necessary adjustments.

4. Once the register and GL distribution are correct, proceed with the

update. FACTS will not allow you to update a register if a hard
copy audit trail has not been printed.

Entering information

While entering data there are a number of points to keep in mind.

At an input, the user may enter one character for each dot displayed at
the input. After entering a character for the last dot displayed, a less

than sign (<) is displayed after the last character and further entry of
data is refused. The data entered for the field is saved.

e There is a difference between a digit and a character. When the
documentation says the input is up to 5 digits it is indicating
that only numeric fields may be entered. When the
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documentation says the input is up to 5 characters, it is
indicating that any character, alpha or numeric may be entered.

e There is a difference between upper case and lower case letters.

e The system contains many fields that must have valid data
entered. This means that the entry must be among valid options
entered previously into a file maintenance program elsewhere
on the system.

¢  When entering information into a field that has a preset list of
entries, a Pick List menu will be displayed. The pick list menu
will have a vertical list of options that can be used. If the field
that is being entered requires that one option be chosen, the
menu will only let you pick one option. If the field that is being
entered will accept multiple options, the menu will display an
asterisk (*) beside the options chosen.

Entering Numbers

e Users may enter a number by invoking the On-Line Calculator,
doing a calculation and then pressing the F10 key to pull the
total back into the data entry section. Refer to the section titled
“On-Line Calculator” for more information.

Entering Dates

e The format mask of the date is set in the company control record
and is either American (MMDDYY) or European (DDMMYY).
When entering dates, valid dates within the mask must be
entered (i.e., always enter two digits for the month (or day), day
(or month), and year). With an incorrect entry, the input mask
is displayed in the input.

e Users may enter one or two digits at the date input and the
system assumes the digits entered are the day of the current
month and year and the full 6-digit date is displayed.

e Users may enter three or four digits at the date input and the
system assumes the digits entered are the day and month
(entered in correct order based on the date mask) of the current
year and the full 6-digit date is displayed.

e Users may enter a date at the date input by entering a + or - and
the number of days either before or after the current date. If the
date wanted is either a week, month or year before or after the
current date, then enter a + or -, the amount of weeks, months,
or years and a w, m or y and the full 6-digit date is displayed.

e Users may enter a date by invoking the On-Line Calendar and
pressing the F3 key to pull the date back into the data entry
section. Refer to the section titled “On-Line Calendar” for more
information pertaining to the On-Line Calendar.

o FACTS applies a “rule of 50” logic to the FACTS programs to
expedite date processing. If the two digit year is greater than or
equal to 50, the system will assume the date to be in the 1900s; if
the two digit year is less than 50, the system will assume the
date to be in the 2000s.

e During data entry, if the system is unable to interpret the date
entered, the date mask will be displayed in the prompt. If the
system is able to interpret the date entered, the date will be

1-52 Copyright © 1984-2005 Infor, Inc.



displayed in the prompt. Dates prior to 01/01/1800 or after
12/31/2199 are not allowed during date entry.

e FACTS programs contain 8-character and 10-character date
fields. The date editing/entry display varies slightly depending
on whether it is an 8-character or
10-character field. When editing a date, using the right arrow or
the END key, will advance the cursor to the end of the date field
and using the left arrow or the HOME key, will advance the

cursor to the beginning of the date field.
L]

While editing or viewing dates:

8-Character
Date Field

10-Character
Date Field

When entering a date in the 1900’s (as defined
by the 50-rule), the date will be displayed as
follows:

ORDERED
01/02/96<

ORDERED
01/02/96 <

Use the right arrow key or the END key to
display the full 4-digit year: ORDERED

/02/1996<

ORDERED
01/02/1996<

A plus sign at the end of the date field indicates
that the year is not in the default century. ORDERED

01/02/96+

ORDERED
01/02/2096<

Prompts

The user should always read the bottom lines of the screen for the user
prompts. These are instructional messages designed to aid the user. In
every menu and program throughout the system, this prompt always
appears in the same place. It instructs users on their options. These
prompts are the key to easy operation of the system.

F4 is an option that is available for almost every input in the system.
Therefore, F4 has been omitted as an option in most user inputs in the
documentation. F4 always backs up to the previous menu, backs up to
the previous input, backs up to a new entry (when paging through F/M
programs) or exits the program returning to the menu.

Defaults

In most programs, default answers to questions are available to users to
save keystrokes on entry. These defaults may appear in one of the
following three forms:

¢ OK to update (Y/N) - In this form where there are two or more
possible answers separated by a /. If the user presses CR, the
system assumes the first possible answer displayed in the
parenthesis (). In this example, the system would assume a’ Y
(yes) response.

e NOTE: if the prompt says OK to update (Y or N) there is no
default since the / is not present. This is used to prevent users
from executing an operation in a critical program without
typing in an answer. For example, when deleting a record the
system’s default is always an N. The user must make a
deliberate effort to delete the record by typing in a YES.
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e Enter beginning customer (CR-First) - In this form if a user
presses CR, the first available record in used. This allows users
to start at the beginning or go to the end of a file without
knowing the first or last record. This is mostly used in reports,
for example, printing a Customer Listing and printing FIRST to
LAST customers (i.e., all customers).

¢ Enter warehouse (CR-01) - In this form a specific default is
displayed in the prompt. If CR is pressed, the specific answer is
used, in this case warehouse 01. These defaults are used when a
specific answer is most commonly used. For example in Order
Entry, at the warehouse prompt, when the majority of the orders
are for warehouse 01 then 01 is the default value.

e In addition to the defaults above, the system is able to assign
defaults for data entry by terminal. For each terminal set up in
the Terminal F/M (in System Management), the following
defaults are assigned: warehouse, branch, department,
salesperson/territory, and printer. Once the defaults are
assigned to a terminal, whenever one of the above mentioned
fields is requested, the system automatically defaults to the
entry assigned to the terminal. For example, if the warehouse
default for a terminal is set to a remote warehouse number,
whenever data entry requires a warehouse number, as in a
purchase or sales order, the program will default to the remote
warehouse number assigned to the terminal. Terminal default
values can greatly decrease data entry errors.
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Function buttons

Following are some of the more common buttons you will find in the
FACTS graphical environment, along with explanations of the
functions they perform.

o Save Save changes. Always save your entries before exiting a
program or file maintenance.

[ e Create a new record in file maintenance programs.
#_ Delete Delete a record. When you press this button, the system

prompts you to verify whether or not you really want to
delete the record.

Exit Exit a program or window. In file maintenances, the
program prompts you to save changes if you did not do
so before choosing Exit.

Go to first record in the file.
Go to the previous record in the file.
Go to the next record in the file

Go to the last record in the file.

Search for information related to the selected field. If
you are in a customer field, choose this to open the
customer search. If you are in an item field, this opens
the item search, etc.

Add a line item. Most often found in entry programs
where users can enter multiple line items.

In SO Order Management Suite programs, add a new
customer. Opens the Quick Customer Add program so
users can create new customer records on the fly while
they enter orders, invoices or counter sales.

Defaults to all available values in a field. For instance,
some of the reports allow users to enter multiple
warehouse codes or route codes side-by-side. Users can
select All, rather than keying all possible entries into the
field.

i 2 S B Eria= E

In report document grids, backs up to previous cell and
deletes any document number in that cell. See Pick List
Print (Sales Orders >Orders 2Pick List Print) for an

example.
< ﬂ Change UM in entry programs. Usually found in line
item entry sections and line item detail windows.
(}_Line Detail | In inquiries, enables you to see more detail on a line
item.
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@ Edit a line item, usually found in entry programs or
anywhere in FACTS where line items appear in browser
windows. See Order Entry (Sales Orders ?Orders 2Order
Entry) for an example.

'Yl V| Set filters in an inquiry. Choose this to set or view
keyword filters, class filters, warehouse filters, etc. A

check mark indicates filters are already set.

EI Insert a line in a browser. Most commonly found in
entry programs where users can enter multiple line
items.

] | Enter no value or don’t use this field. Commonly found

in reports and file maintenance programs when the field
is not applicable.

See more options. Mostly used in reports, prints and
registers in fields in which users can enter several letters
in one field to indicate options they want to include.
Users can press this button to see what the letters stand
for. See Item Ledgercards for an example (Inventory
Control PReports & Prints Dltem Ledgercards).

Set field to full balance of order. Used in the multiple
payment sections of SO Order Management Suite
programs. Users can select one of the payment fields
and choose this option to indicate that the entire
document balance is being paid with either check, credit
card, cash, etc.

ﬁﬂ Perform a price search. Allows users to inquire about
different price levels and previous prices offered to a
customer for the selected item.

g Cancel line item entry. Usually found in entry
programs.

In Vendor, Item, Customer and GL inquiries, this
indicates the Sync! feature is enabled.

Indicates the Sync! feature is disabled. Users can enable
the feature by selecting the button.

Default to system date.

Temporary ship-to. Located in most SO Entry programs,
users can choose this option to create a temporary ship-
to address for a customer.
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Using Character FACTS

CUI FACTS is the character version of the FACTS interface. It is
designed to run on UNIX terminals, but users on Windows stations can
run the character interface if they wish.

Signing on to FACTS from terminals

T

Financial Accounting System

Copyright(c) 1984-97 Software Solutions, Inc. ALL RIGHTS RESERUVED.
Demo Gompany
This software contains TRADE SECRETS and CONFIDENTIAL INFORHMATION
of Software Solutions, Inc. (SSI), Atlanta, Ga. and may only be
distributed by SSI or its authorized distributors in accordance
with the terms of the SSI customer agreement.

Terminal on stand-by. CR-Sign On, Fia-End

USER CODE SSI Stephen S. Invincent
PASSHWORD
COMPANY 81

Enter company to work in (CR=81), Fu-Backup

.

The first screen that appears is the banner screen. Press the Enter key
(CR) to continue to the sign on screen. To exit from this screen, press
the F4 key.

The Sign On screen appears next. At this screen, enter your

e User code
e Password
e Company Number

Then press Enter (CR).
Press the F4 key return to the banner screen.
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Navigating with menus in CUI

Essentially, the character and graphical menus work the same.

™, Company 01, FACTS 7.5 Development !EE
Help
B1-FACTS 7.% Developme MHS 888

** Copyright{c) 1984-2085 Infor. All rights reserved. ==

Selection |

ENTER SELECTION #, ACCESS CODE, "OFF', ARROWS, F4-PREVIODUS HEHU

The top of the menu screen provides several pieces of information for
your convenience (clockwise from top left): System date, menu name,
terminal ID (discussed further in the Terminal F/M section), time,
program name and company information.

To select a menu option: Enter the option number in the selection
prompt or select the menu option with the arrow keys on your keyboard
and press Enter (CR).

Menu time outs

System Administrators and Implementation Consultants can set the
menu system to “time out” and return to the Sign on Screen if it is
inactive for the designated amount of time.

This is a security feature that helps prevent unauthorized users from
accessing sensitive data at unattended stations.

For instance, your local FACTS Affiliate may set the menu to time out if
it is inactive for five minutes. If you take a lunch break and forget to log
off, FACTS logs off for you.

Signing on and off with FacetTerm

FacetTerm allows a user to have access to multiple sessions (sign-on
screens) through one terminal. It has the same effect as having several
working terminals on one desk. You can be signed into as many
different FACTS screens as you have FacetTerm windows. The signing
in process is the same as if FacetTerm were not being used. After
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signing in each window can be accessed by pressing the FacetTerm
access key of Control-W and then entering the number of the window
desired, or by pressing the FacetTerm pull down menu key of Control-F
and then using the cursor keys to highlight the window desired. The
menu will display which windows are signed in and what programs
they are currently running. Refer to your FacetTerm manual for other
options available while using FacetTerm.

Each FacetTerm window functions independently. Therefore, each
window needs to be signed off independently. The Menu Time-Out
value set in the System Control F/M does time out each window.
Access Codes

The same access codes can be used in graphical and character user
interfaces. They provide quick access to modules, submenus and
programs.

FACTS ships with a default set of users codes; however, a system
administrator or your local FACTS Affiliate can create new codes to fit
your company’s needs.

Preset FACTS Access Codes

AP  Accounts Payable MM  Master Menu

AR  Accounts Receivable OA Office Automation
CS  Counter Sales PO Purchase Orders
EDI Electronic Data Interchange = PR Payroll

FL  FaxLink RW  Report Writer

GL  General Ledger SA Sales Analysis

IC Inventory Control SM System Management
JC  Job Cost SO Sales Orders

JS Job Stream SR Service and Repair
MC  Manufacturing Control TF TeleFACTS

Access codes for standard menus

To access the Inquires menu in any module, add an I to the access code
for the main module. Example: Type ARI to access the Accounts Receivable
Inquiries menu.

To access the Reports & Prints menu in any module, add an R to the
module’s access code. Example: Type ICR to access the Inventory Control
Reports menu.

To access the End of Period menu in any module, add an E to the
module’s access code. Example: Type POE to access the Purchase Orders
End of Period menu.

To access the File Maintenance menu in any module, add an F to the
module’s access code. Example: Type SOF to access the Sales Orders
File Maintenances menu.

To access the Infrequent File Maintenance menu in any module, add
an IF to the module’s access code. Example: Type GLIF to access the
General Ledger File Maintenances menii.
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© Menus may be restricted to certain users. Access codes do not work
if a menu is restricted.

Access codes for module-specific menus

For example, in Accounts Payable, the first three menus are Document
Entry, Payments and Holds and Checks. These menus are unique to
Accounts Payable and are only found on the Accounts Payable master
menu. The menus may be accessed by typing the module code and the
selection number of the menu listed on the master menu of that
module.

For example, the AP document entry menu may be accessed by typing
AP1, the AP payments and holds menu may be accessed by typing AP2
and the AP checks menu may be accessed by typing AP3.

Affiliates and Administrators: Use Program F/M (System

Management >Menu Setup ?Program F/M) to customize access codes.

Access codes may be up to 6 characters (the first character must be
alpha).
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General information about character programs

Prompts

If you are unsure about what do next in a program, read the bottom
lines of the screen for the user prompts. These are instructional
messages designed to aid the user by communicating what options are
available and which letters or function keys to choose to access these
options.

Prompts appear in every program throughout the system.

The last line of the prompt section usually tells you how to navigate
through the information in the program. For instance it tells you if the
Up and Down arrow keys take to the next line in a browser or the next
record in a file maintenance.

Important Keys

The keys marked F1, F2, F3 and F4 on your keyboard are the function
or control keys. If these keys provide an operation in the programs
being used, the key number and its operation are displayed in the user
prompt.

For example, the F4 key usually backs up to the previous input.

F2 usually provides access to a search or allows you to look up
information.

F3 usually ends a process and saves the information you enter. For
instance, in order entry, the system tells you to choose F3 to indicate
that you are finished with line item entry.

F1 is often used to enter defaults in inputs or to skip inputs that you
don’t use.

S Though these are the most common functions assigned to these
keys, always refer to the prompt at the bottom of the screen to verify
what the function keys are assigned to perform.

CR to Continuve

CR-Continue is used throughout FACTS. Whenever you see this in a
prompt, press the Enter or Return key to proceed.

On-Line Access and Special Function keys

While signed into FACTS, there are specific on-line functions that can
be accessed by pressing a Special Function Key. These are actually key
combinations you can use to invoke certain functions defined in the
System Management Terminal F/M program.

Your local Affiliate’s Implementation Consultant usually sets these
defaults during installation and initial setup.

Copyright © 1984-2005 Infor, Inc 1-61



The available functions are:

On-Line Calendar

You can invoke the on-line calendar from anywhere in the system by
pressing the hot key defined in Terminal F/M. The default key for the
FACTS System is CTL+D, but you can change this in the Terminal F/M
Screen. You can also copy a date into the system from the calendar by
pressing the F3 key if you are in a date field.

On-Line Calculator

You can invoke the on-line calculator from anywhere in the system by
pressing the hot key defined to it. The default hot key for the FACTS
system is CTL+V, but you can change this on the Terminal F/M Screen.
You can also copy a total from this calculator into any amount field in
the system by pressing the F10 key. This calculator operates similar to
an adding machine in that the operation (+, -, x, / or *) be entered prior
to entering the number.

SO Quick Look

You can invoke a quick search from the SO entry programs by pressing
the hot key defined to it. The default hot key for the FACTS system is
CTL+B, but you can change this on the on the Terminal F/M Screen.

SO Quick Look is a helpful reference feature that is available in the SO
Order Management programs (Order Entry, Order Confirmation,
Direct Invoice, Credit Memo, Counter Sale Entry and Service Order
Entry). Refer to Appendix A (Soa.pdf) in the Sales Orders manual for
more information.

On-Line Help

The default special function key for On-line Help is CTL+L. The
character On-line Help system allows you to search for help topics by
module, program or keyword.

The information appears in the character viewer, which is also used in
reports.

Note: Unix users have the option to run the Unix utility, dtox (dos-to-
unix), on the .ssh help files to enhance readability by converting the
<LF><CR> sequence to <LF>. For more information about this process,
consult your UNIX source material.
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Using searches

Searches allow you to find specific information quickly, such as
customer number, item number, vendor number, warehouse, etc. When
a search is available on an input, F2-Search appears in the prompt lines
at the bottom of the screen.

All search windows include browser boxes in which searchable
information is displayed. View information in the browser by scrolling
vertically and horizontally.

)\ Customer F/M [ARFI10) [_ O[]

Help

B1-FACTS 7.4 Development Customer F/H ARF91d
*, Customer

2. Hame
Customer Search

KEYWORDS Hone AHD Hone

Llass All Slsp/Terr ALl

LN Alpha Customer Hame City, State C
2 BARHMES HMAC C184 Barnes Hachinery & Equipment Atlanta, GA J
3 BIKES FOR C132 Bikes for Tykes ntlanta, GA P
4 BRADLEY HA C119 Bradley Manufacturing Co. Atlanta, GA L
5 CASH £222222CASH CASH o
6 CENTRAL GA C187 Central Georgia Materials Co. Douglasville, GA s
7 CENTRAL VA G112 Central Valley Water Company Norcross, GA b
8 COWBODY WOR C111 Cowboy WYorld San Antonio, TX J
9 DALLAS FUR C185 Dallas Furniture Hart Fort Worth, TX T
18 DELUXE EQU C181 Deluxe Equipment Warehouse Douglasville, GA 3
11 DISCOUNT I C125 Discount Industrial Warehouse Atlanta, GA J

F2-0Order: Alpha, Contact, Phone, Customer, Class, F3-By Ship-To
Enter beg alpha, F1-Set Filters, ?'+F1-Options, F4-Backup [..........
Down

Use the Up, Down, Left and Right arrow keys to scroll vertically and
horizontally in the browser.

Select information from the browser by highlighting the line in the
browser and pressing Enter (CR).

‘Enter beginning’

Searches prompt you to enter the beginning characters of the
information you want to find. If you have trouble locating the
information you want to find, use the following tips:

1. Asyou enter look-up information in the Go To field, the search
program advances the highlight bar to the first closest match. All
the searchable information remains in the browser so you can
scroll up or down through the entire list.

2. Searches are case sensitive. If data was entered into the system with
the Caps Lock on, Caps Lock must be on when you search for it.

3. Check the sort order that is selected. This is important to remember
in searches with multiple sort orders. For instance if you are in a
Customer search with the Customer Number sort order selected, a
search for C220 probably will be successful, assuming the
customer record C220 exists in your system. However, if you
switch to the Contact sort order, C220 will take you to the first
contact name that starts with C.

S Entryis Beyond the Last on File. This is a common error message in
searches. Try entering the lookup information in either ALL CAPS or
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lower case, and make sure the lookup information you entered
corresponds to the search order you selected.

Filters

Use filters to focus on specific information. When you enter a filter, the
search eliminates from the browser any information that doesn’t match
the filter criteria.

Filters are not case sensitive and they are not tied to the selected search
order. In other words, if you enter the keyword copper, the search looks
through all information -- including alpha, descriptions, contacts,
cities, states — and returns any entries that contain that word.

Sort orders
Use sort orders to put information in a certain sequence.

For example, if you are performing a customer search, you have the
option of sorting the information according to alpha, customer, contact,
phone number or customer class. The information that you sort by
appears in the first column of the browser window.

For instance, you may only know the customer by its FACTS customer
number (i.e., C100), so you choose to search in customer order. When
you do the information in the browser reorders according to customer
number and the customer number shifts to the first column position.

To select a sort order:

Press F2 and select a sort order from the popup box or enter the
highlighted letter in the selection prompt and press F2.

Most searches default to the alpha order if it is available, but each user
can select which sort order the search defaults to when they open it.

Customizing searches with Preferences

All FACTS searches offer their own user-definable preference settings.
These settings allow you to control a number of features, such as the
default sort order, the number of lines that appear in the browser,
which column headers appear in the browser and which filters appear
for each sort order.

Setting search preferences

To access Search Preferences, type ! in the selection prompt and then
press F1. Then enter F to access the Search Preferences window.

Set search orders on the left. Establish column headers on the right.

Tip

If the search
cannot find a
match to your
search criteria and
the browser turns
blank, exit out (F4)
and re-enter the
search (F2) to
refresh the
screen.
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7\ Customer F/M (ARF310]) =]
Help

81-FACTS 7.4 Development Customer F/H ARF916

*, Customer
2. Hame
r Customer Search

search Preferences
Column Selections for Alpha Order

Sort Orders: Unselected Columns: Selected Columns:
Contact alpha
Contact Order Phone Customer
Fhone Order Hotes Hame
Customer Order City, State
Class Order Contact 1

Phone 1

Contact 2

Phone 2

Locked Columns: 1

Default Order: Alpha Save User Preferences: Yes

Set Default Order, Toggle Save User Preferences
F1-Columns, F3-Accept Changes, F4-Cancel .

Setting the default sort order for a search. Enter D, then use the up
and down arrow keys to select a default sort order. The selection
appears in at the bottom of the Search Preferences window.

Setting filters. Highlight a search order and enter the filter number to
toggle it on or off.

Saving Preferences as User Defaults. Enter S in the selection prompt
and press Enter. The Save User Preferences control is only accessible
from the sort order side of the Search Preferences window.

S  To exit the Search Preferences window, press F3 to save changes
and return to the Search window. Press F4 to Cancel any changes and
return to the Search window.
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Editing the columns in the search browser

Each user can determine which column headers appear in the search
browser and in which order the columns should appear.

Press F1 to access the right side of the Search Preferences window and
press F1 again to move the cursor to Selected Columns (F1 allows you to
toggle between the Selected and Unselected columns.

The columns that appear in the browser are listed under Selected
Columns.

To remove a column from the browser, highlight it and press the Enter
key. The column title will appear under Unselected Columns.

To add a column to the browser, press F1, if necessary, to toggle to
Unselected Columns and press the Enter key. The column title will
appear under Selected Columns.

Shortcut: Press to F2 to select or deselect all column titles.
Removing user preferences
Type ! and press F1. Select Reset to System Defaults from the picklist.

S Resetting to system defaults clears any saved filters and resets all
search preferences back to the default FACTS settings.

Exporting search results

This option enables you to examine your FACTS search results in an
Excel spreadsheet, or you can export search results to a flat file so they
can be used in other programs, such as word processors, contact
managers, etc.

< This feature may not be available to all users. A security code must
be assigned to users’ records in User F/M.

To export search results to a flat file (ASCII):
1. Open asearch.

Type the beginning characters, and use the Filter fields if
necessary, to locate the information you want.

3. Once you have the desired information in the browser, type! and
press F1. Select Export to ASCII from the picklist.

4. Name the flat file. You do not have to enter the .txt extension to the
file name; it will be added automatically.

FACTS saves the flat files to ssi7/fileprt or ..ssi7\fileprt by default.
To save the file to another drive and directory, specify the path in
front of the file name.

Example: C:\ My Documents\ myflatfile.
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Printing search results

You can output your search results to any FACTS printer or to the
character viewer.

To print search results:

1. Type the beginning characters, and Filter fields to get the search
results you want.

2. Select the Print option from the menu bar and select one of the
printer options. If you select either the Windows (graphical only)
or the FACTS printer options, choose a printer from the dialogue
box. The viewer automatically opens when you select it.

Character search shortcuts

Different combinations of the above searches are available from
different places in the FACTS system. After pressing F2, a menu
appears at the bottom of the screen listing the search options available.
r Item Search

KEYWORDS Hone OR Hone

Class WHS Item Type All MWarehouse ALl

LH Alpha Item Type Description UM Clas
1 ADJUSTABLE 1998 U Adjustable Height Steel Stool EA  WHS
2 ADJUSTABLE WEITUNE U Adjustable Height Steel Stool EA WHS
3 BIH BOXES 1117 Corrugated Bin Box EA WHS
4 BIH BOXES TIHSI117 Corrugated Bin Box EA  WHS
5 BOOM TELE 1186 Telescopic Lift Boom EA  WHS
6 CABIMET 5T 1118 Steel Storage Cabinet EA UWHS
¥ CASTER SWI I142 Swivel Caster EA  WHS
8 COMTAINER 1123 28 gal Waste Container EA WHS
9 CONUVEYOR B 1185 Hesting Conveyor Box EA WHS

18 CONUEYOR R 1126 Gravity Roller Conueyor EA WHS

11 CORRUGATED I6666 U Corrugated Bin Box EA  WHS

F2-0rder: Item #, Alpha, Interchange, Class, F3-Alt Look

Enter beq alpha, F1-Set filters, *+F1-Options, Fi-Backup |..........

As shown in the graphic above, underlined letters represent each search

order and filter option.

To switch search orders only: Enter the underlined letter at the

selection prompt and press F2.

Example: To switch to the item number search order, enter N and then Tip

press F2.

To switch search orders and begin listing at a specific record: Enter
the letter representing the search order, followed by a period and the
beginning characters, then press F2.

Example: To switch to Alpha search order and begin listing in the Ps,
type A.P and press F2.

To setup a filter: Enter the letter representing the filter you want to use,
followed by a period and the information by which you want to filter
and then press F1.

Example: To filter the search by Warehouse Class, type A.WHS and
press F1. This limits the search to Warehouse Class items.

To switch search orders and setup a filter: Type the search order letter,
the filter letter, a period and the information by which you want to
filter. Press F2 to complete the command.
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Other searches in
the system have
different search
orders and filter
options.

Familiarize
yourself with each
searches option to
make sure you are
entering the right
access letters at
the search

prompt.
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Example: To switch to Item Number search order, filter by warehouse,
and for items starting with 1130, type NW.I130 and press F2.

File Maintenances

During installation and setup, you use certain file maintenance
programs to enter information into the system (such as customer, item
and vendor files). Implementation Consultants and System
Administrators use other file maintenance programs to control how
FACTS processes information and which features are available to the
users.

Often called F/Ms for short, these programs can be used at any time to
modify or maintain system data.

< Keep in mind that any changes you make can deeply impact your Key field
data and the way FACTS processes this information. This term refers to

the input or field in

Some F/Ms, such as Customer, Item and Vendor F/Ms, allow you to :
which you create

create and maintain multiple records. When you add a new record, you the record’s
enter a unique code, which also referred to as the record number. You unique ID or
number.

will use these codes throughout the system whenever you need to

identify this record. For instance, the

Customer
The inputs in which you enter these codes are sometimes referred to as Number input in
the key fields Customer F/M is

ey ’ the key field for

Other F/Ms, such as the Static and Nonstatic Control F/Ms, are single- that program.
record programs. These F/Ms primarily contain controls and settings Itis ihe inpltlt you

use to create a
that affect the way FACTS operates. T T o
For instance, the Sales Order Static Control F/M contains controls and customer record.

flags that activate — or deactivate — features such as Cash Drawer
Handling, Remote Order Entry and Job Costing, to name a few.

Single-record F/Ms rarely require data entry, and FACTS
Implementation Consultants are usually responsible for setting the
controls and flags in these programs.

Using File Maintenances
To add a record (in multi-record F/Ms only):

1. Enter a unique code. These are usually alphanumeric and their
lengths vary from program to program. Press Enter. Some F/Ms
contain several key fields.

2. When the program asks you to verify that you want to create a
new record, enter Y and press Enter (CR).

3. Complete the inputs. Some file maintenances contain several tabs
of inputs. As you finish entering information on one tab, the
program automatically advances you to the next one.

4. When you complete all the inputs, press Enter (CR) to save the
changes. Type a Y and press Enter (CR) to confirm that you want
to save the changes.

Press F4 to cancel the changes and type N to confirm that you
want to abandon the changes.

5. Press F4 to return to the key field where you can enter another
record or press F4 to exit the program.
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To browse records in multiple-record F/Ms:

1. Inamultiple-record file maintenance, choose F3 to bring up the
first record on file or enter a code. Press F2 to find a code.

Repeat this step if there is more than one key field in the file
maintenance.

2. Use the Up and Down arrow keys to page through each record,
Page Up and Page Down keys to access the first and last record
available for that file maintenance.

To edit a record:
1. Select the record by entering its code or press F2 to find the code.

2. Edit the necessary inputs by entering the line number of the input
that you want to change.
Tip: Enter the line number followed by F2. This enables you to use
the Enter key to navigate through the rest of the inputs in the file
maintenance. This may be helpful if you need to edit more than
one input.

3. When the edits are complete, press Enter (CR) to save changes and
type Y to confirm, or press F4 and type N to cancel the edits.
In either case, the cursor returns to the key field, where you can
edit another record or press F4 to exit the program.

To delete a record:
1. Select the record by entering its code or press F2 to find the code.

2. Enter D and press the Enter key. Enter Y and press the Enter key
to confirm.

S Before you delete a record, review the documentation for that file
maintenance.

Some records, such as item, customer and vendor records, cannot
be deleted until you delete all documents that reference those
records or complete processing those documents.
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Inquiries

Inquiries are similar to searches in that they enable you to look up
information stored in the system. However, inquiries provide much
more in-depth information than searches.

Each inquiry program offers different view options. For instance, in the
Vendor Inquiry you can view general information for each vendor,
including contacts, status, phone numbers, etc. You can also view
activity for each vendor, open and paid invoices, notes, payment
history and ledgercards.

You may find it helpful to have inquiries open while you are working
in entry programs so you can view information as you enter invoices,
orders, purchase orders, etc. If you are entering purchase orders, for
example, it may be beneficial to have the Vendor Inquiry program open
at the same time.

Inquiry windows are made up of three sections:

The inquiry browser, which enables you to select the subject of your inquiry, such as an item,
customer or account.

The view bar, in the center of the window, which lets you access different views available on the
subject.

The view area, where the program displays the information you requested on the subject. The view
area may present display-only data or it may present a list box. In most cases, list boxes enable you
to get more detail on each line item listed.

Inquiry window

™\ Item Inquiry (ICI610] [—[OI=]

Available records are liEty Activate Sync! to get
E’Sted in thl(j inc:rl;lir{j  TTTACTS 78 Developnent Tten - Alpha Order icieig)| real-time inquiry

rowser. Use the Up an information as you work
Down arrow keys to Alpha 1tem Tupe Hotes Description Desc in ent ro rar).lns Type

¢ 3 X 3 X 3/ Z3X3K3/16 PRINED 3 X 3 X 3/16 PRINED LINNEAL ry prog - 1yp
scroll vertically. At the 3-Sucket E 1300 3-Socket Emergency Lanp !'and press F1 at the
88 ZFLO HTR u 488
prompt‘ type ¢ and press Go To Filters Off prompt. Select T_°gg_|e
the Right or Left arrow Sync D Sync! from the pick list.
+
E?ér?trgrriisftzs)bv kgj glanket S0 Gast General
) WH On hand Out of balance Pd lowest 12 PD av HTD sales .

to scroll horizontally. - n hand e 9 e Arrows indicate

more views are

available.
Use the Right and Left
arrow keys on your
k_eybc_)ard to h_|gh||ght a 01
view in the viewer. d¢é€r: Item #, Alpha, Interchange, Class .
€ beginning alpha, F1-Edit filters, h3-Uiew, F4—End, F18-Henu |._........ Use the selection

prompt to type in
lookup information

The view area )
and enter options.

displays information

for the record and

view highlighted. Refer to the prompt for F3 enables you to toggle between the top
instructions and options. and bottom browsers.
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Using Inquiries
1. Enter the beginning characters in the selection prompt and press
Enter to find the record on which you want to inquire.

In the Vendor Inquiry, for example, enter a vendor number, alpha
lookup or beginning characters of a vendor’s name. The prompt at
the bottom of the screen tells you what format you need to use. In
inquiries with multiple sort orders, press F2 to change orders.

Available records are listed in the inquiry browser. Use the Up
and Down arrow keys to scroll vertically.

You can also scroll horizontally to view additional inquiry browser
record information. At the prompt, type ¢ and press the Right or
Left arrow key or press CTRL + the Right or Left arrow key to
scroll horizontally.

Once the record is highlighted, you do not need to press the Enter
key to select your inquiry focus.

2. Select a view.

To select a view, press Shift + = and Shift + € to change the view
to the left or right or use the << (left) and << (right) arrow keys on
the screen. The information in the view area will change according
to the record and the view you have selected.

Or press F10 to access Inquiry menus and select the View.

3. If the selected view is a list of documents or records, press F3 to
work in the lower half of the screen.

Use the Left and Right arrows to scroll horizontally in the list
view.

Use the Up and Down arrows to scroll vertically in the list view.
Use the Home key to jump to the first record on file.

Use the End key to jump to the last record on file.

Use the PgUp and PgDn keys to jump through records quickly.

4. Press F3 to return to the top inquiry browser and select a new
record.

To exit the inquiry: Press F4.
How files load in list views

List views can potentially contain a large number of records. For
instance, if you select the Open Documents view in Customer Inquiry,
your system may have to load a hundred records. If the system
attempted to load all the records at once is may take several minutes for
anything to appear.

Most views are set to load 50 records at a time. Press F1 to reload the
list view with the next group of records.
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Using inquiry features
F1-Edit filters.

Use filters to narrow the search for records in the inquiry browser.

r Filter Ualues
Keywords [General OR Reardon
Starts With Hone

Class Hone

Keywords filters are useful when you're trying to find a record but
can’t locate it by typing lookup information in the selection prompt.
Keywords can be connected by or - which searches for records
containing either of the words - or by and - which searches for records
containing both words.

Use Starts with when inquiring by unique record IDs, such as vendor
number, item number, customer number and so forth.

Additional filters, such as Class, Slsp/Territory and zip code, may be
available, depending on the inquiry.

Options.
From the Options menu, you can
e Set view preferences
e Setinquiry preferences
e Save current filter values
e Reset preferences and filters to system defaults
e Toggle Sync!
e Enter notes

To access any of these features, type !, press F1 and select the feature
from the list box.
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Setting view preferences

Inquiries such as Item Inquiry include close to 25 views. Use view
preferences to quickly access the views you use most and hide the
views you don't use at all. View preferences are specific to each user.

- Uiew Preferences

General Hidden Ho
Codes Favorite Ho
Activity
Open Docs
Paid Docs

Payment Hist

Toggle Hidden, Toggle Favorite

Set Uiew attributes, F4-Backup |-

Select a view with the up and down arrows and type H to hide it from
the view bar or F to set as a favorite so it shows up at the beginning of
the view bar. Then press Enter.

Setting inquiry preferences

Inquiry preferences are similar to search preferences. This function lets
you personalize certain inquiry function to meet your day-to-day
needs. Preferences are specific to each user.

Two sections make up the Inquiry Preferences window: the sort order
section and the column header section.

r Inquiry Preferences
Highlight the sort  gers: Unselected Columns: Selected Columns:
order that you want mﬂ 4 39"30" "
. . rder endor Hame
in affect each time Humber Order City, State
you enter the nlpha
inquiry. Enter D in Contact
th ry te Contact 1
the prompt. for Alpha: Contact 2
s Yes Vendor Class

2} Ho

3) Ho Locked Columns: 1
Choose which Order: Alpha Save lUser Preferences: Yes

filters should

H t Order, Toggle Save User Preferences
a_ppear Ir.] the ter # To Toggle, F1-Columns, F3-Accept Changes, F4-Cancel |.
Filters window for =Previous Order, Down=Hext Order

each sort order.

Sort order section

Setting default sort orders. With the up and down arrow keys,
highlight the sort order that you want in effect each time you open the
inquiry. Enter D in the selection prompt and press Enter.

Setting filters for each sort order. This feature can help eliminate
keystrokes. If there are certain filters that you do not use in a search
order or in multiple search orders, you can turn those filters off. Enter
the filter number in the selection prompt and press Enter. To toggle the
filter back on, enter the filter number again and press Enter.

Saving user preferences. Enter S and press Enter to toggle this feature
on. Repeat the steps to toggle it off. When this flag is set to Yes, the
system saves all the settings as your user defaults.
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column headers
that appear in the
inquiry browser.

Enter T in the
prompt to Save user
preferences.
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Column header section

Use the column header section to add or remove columns from the
inquiry browser. Press F1-Columns from the sort order section to
access column header settings.

To add columns to the inquiry browser:

Use the up and down arrow keys to highlight an Available Column
title. Press Enter (CR) to move it to Selected Columns. Repeat for each
column title or press F2 to select all available columns.

To remove columns from the inquiry browser:

Press F1-Edit Selected to move the Selected Columns. Use the up and

down arrow keys to highlight a column title and press Enter (CR) to
move it to Available columns.

Saving filters

Use the Save Filters feature if you want to keep filters for future use.
The system saves filters on a user-by-user basis. In other words, the
filters you save will not be available to other users.

Sync!

Sync! is a method of connecting the entry programs with information
displayed in customer, item and vendor inquiries. You may find it
helpful because it enables you to get real-time information such as
customer balances, vendor balances and warehouse quantities, while
you are working in entry programs.

You can initiate Sync! from the following programs:

e SO Customer Inquiry (SOI1610)
e AP Vendor Inquiry (API610)

¢ AR Customer Inquiry (ARI610)
e ICItem Inquiry (ICI610)

< Inquiries are synchronized on a per user basis. In other words, if
you are signed on to FACTS in one window with one name and signed
on in another window with another name, it will appear as if the Sync!
function is not working.

To use Sync!:

1. Open the inquiry and entry programs you want to use.

2. In the inquiry window, press F10 and select File ?Sync! from the
menu.

3. Return to the entry window and begin working. As you enter
information into a document, the inquiry information will update
automatically.

To turn off the Sync! feature, return to the main inquiry window and
choose F10. Select File 2Sync to toggle off the Sync! feature.

Technical note

While Sync! mode is activated, the inquiry program will examine a file
called SMUSED approximately every three seconds. This file contains
the last customer number, item number and vendor number input in
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Sales Order Entry. If this number is different than the one currently
being displayed in the inquiry, the inquiry will change its display to
show information on this new customer, item or vendor.
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Using Report, Register and Print Programs

Reports print information in a specific format, but they do not update
the system. An example is the Open Receivables Report, which lists all
the open receivables in the system along with other information

Print programs output to forms, such as checks, 1099s, invoices,
purchase orders, bills of lading, etc.

Registers print information and then provide an optional update,
which posts the register information to the appropriate files. For
example, after invoices are printed, they print on the SO Daily Sales
Register. If you update the register, the invoices then post to the open
receivables file, sales tax file, etc.

Most report and print programs allow you to
Select the order in which you want the information to print,
Set a range of information to print and
Edit properties, which vary with each report.

For example, the AR reports give you the option of printing in
customer number, alphabetical, salesperson/ territory or customer class
order. If you choose to print a Customer Listing in customer class order,
the report will sort and print all of the customers by class.

Once you select an order you can then choose the beginning and
ending records that you want to print. The system always defaults to
FIRST and LAST. These two fields enable you to filter your report by
entering ranges.

In the Customer Listing example, you could enter Retail for beginning
class order and Retail for ending class order to generate a report listing
just your retail customers.

In addition to order and range, all reports and prints have a variety of
properties that enable you to fine tune your reports.

Once you have answered all the questions in the report, click OK or
press CR.

Most FACTS reports print in 132-column paper (11 %2 x 14 inch paper).
However, some reports, such as the Chart of Accounts, print on 80-
column paper (8 %2 x 11 inch paper). The END OF INPUTS statement
indicates where 80-column paper may be used. All reports, except GL
financial reports, print on each page the time and date the report was
printed, the user, the terminal from which the report was run, company
name, report name, program name and page numbers. The order and
the beginning and ending range appear at the top of the report.

Using reports in the character interface

To edit order, range and properties, press F3.

To select or create templates, press F1.

To set or change print settings, press F2.

When a report finishes printing, one of two prompts appears:

1. END OF REPORT. CR TO PROCEED always displays unless you
are printing the report to the character viewer. If you do not
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respond in 5 seconds, the system automatically proceeds back to
the menu system.

2. END OF REPORT. CR TO CONTINUE displays if you print the
report to the character viewer. The program will not automatically
proceed to the viewer unless you press CR.

Using print options

On each report, you can select the type of output device to which the
report should print, select or deselect beginning and ending form feeds
and adjust the number of lines in the top and bottom margins.

Print options can be set each time you run the report by selecting Print
Options >Properties from the menu bar in the graphical interface or by
pressing F2 in the character interface.

To save time, you can also save print options in templates. For instance,
you can create one template so a report outputs to a printer, create
another template so the same report outputs to a Fax and then create a
third template so the report outputs to the viewer so you can preview it
on screen.

Print to option

In FACTS, you can output reports to a printer, viewer, flat file or you
can output to other software packages, such as VSI-Fax or Archive.

Printer gives you access to any of the FACTS printers set up in Printer
F/M. In graphical, select the printer from the dropdown list. In
character, continue to the Printer/File field and press F2 to search the
list of available printers.

Viewer enables you to review a report on screen. Both the graphical
and character viewers have search and scrolling capabilities. The
graphical viewer is also equipped with print capabilities, as well as a
clipboard feature.

File lets you print the report to a flat file format. This enables you to
import report information into other software programs such as
spreadsheets, databases, word processors. You can also attach the flat
files to e-mail messages. FACTS automatically saves flat files to a folder
called fileprt. To save the file somewhere else, preface the name of the
file with a directory path. For example, C:\ My

Documents\ agedtriall.txt.

Fax sends the report information to VSI-FAX, giving you desktop
faxing capabilities. This option is only available on systems using the

Faxlink module. If you have questions about this feature, contact your
local FACTS Affiliate.

Archive is only available on systems using Archive™ software by
Designed Data Systems, Inc. This is an on-line storage and retrieval
system that lets you automatically build a library of important
documents.

Form feed options

If you are outputting to a dot-matrix printer, or any printer other than a
laser, these two options let you establish where the form feeds occur, if
atall.
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# Lines Margin option

Use this control to adjust the number of lines in the top and bottom
margins. All FACTS forms print 53 lines per page by default, leaving a
top and bottom margin of 5 lines each.

You can adjust the number of lines in the top and bottom margins from
1 to 20. The default is 5. Keep in mind that if you increase or decrease
the number of lines in the margin, the number of lines in your report
will inversely decrease or increase

Viewing reports on screen

The character viewer can be helpful if you want to preview your report
before you print it on paper. The viewer also lets you quickly review a
document at your desk without having to wait for the report to print.

Using the character viewer
Start the viewer.

Select viewer in the Print Properties window (press F2). Run the report
and press CR when “End of Report. CR to Proceed” appears at the
bottom of the screen.

Use the navigation controls to review the document.
When the viewer first appears, the following options are available:
G - Go to Page. Use this option to skip to a page in the document.

F2- Text Search. Use this option to find an instance of a word, number,
date, etc. Once you perform a text search two more options appear -
Next Search and Previous Search. Enter up to 10 characters and press
CR.

N - Next Search. Use this option to go to the next instance of your
search criteria.

P - Previous Search. Use this option to go to the previous instance
of your search criteria.

F4 - End. Use this option to exit from the viewer and return to the menu
system.

The Home, End, Page Up, Page Down and arrow keys can also be
used.

Use the Home key to jump to the first page in the document and the
End key to jump to the last page.

Use the Page Up and Page Down keys jump to the previous or next
page in the document.

Also, use the up and down arrow keys to scroll vertically through the
document line by line and the left and right arrow keys to scroll
horizontally column by column.

Using the GUI viewer

Using report templates

The template feature allows you to save a combination of entries so that
you don’t have to reselect them every time you run the report. Each
user can create an unlimited number of templates in any FACTS report.
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Once you create templates, you can edit them, delete them or change
their properties.

In the Template Properties window, you can change the name of a
template, set it as your default template for that report, set up a default
printer for that template, select or deselect beginning and ending form
feeds and modify report margins.

The system remembers the last nine templates used and displays them
at the bottom of the Templates menu for faster access.

Both user-specific and system templates are specific to the report in
which they are created.

Creating user-specific templates
1. On the main screen, set up the report order, range and properties.
2. Press F1 and select create.

3. Name the template. Template names can be up to 35 characters
long. Make sure the System Template option is not selected. Type
YES and press the Enter key. The template name displays at the
bottom of the main screen to show that it is selected.

Creating system templates: Follow the same steps for creating user-
specific templates, but select the System Template option. System
templates are available to any user that has access to the report in
which it is created, but not all users can create system templates. Users
must be setup with the necessary security codes to have access to this
function.

Selecting existing templates

1. Press F1 and choose Select from the pick list.

2. Use the arrow keys to select a template and press CR.

Setting a default template

You can set template properties so that one template is selected every
time you open a particular report.

1. Press F1 and choose Select from the pick list.

2. Use the arrow keys to select the template.

3. Enter P at the selection prompt and press CR.

4. Change the name in the first field in the Templates Properties

window.
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Deleting a template

Press F1 and choose select from the pick list.

Select the template with the arrow keys and enter D. Press CR.
Changing a template name

1. With the template selected, press F1 and choose Properties from
the picklist.

2. In the Template Properties window, enter a new name.

3. Press CR to return to the selection prompt on the main screen.

Editing the report values stored in templates

1. Select the template if it’s not selected already.

2. Press F3 and change the order, range or properties.

3. At the selection prompt, press F1 and select Save Entries (or enter
E).

4. A message will appear confirming the changes to the template.
Press CR to return to the selection prompt.

Setting printer properties in templates

Each template can have its own printer properties so that you don’t
have to set them each time you print the report. However, you can
override the template print options on a print-by-print basis by
pressing F2.

1. With the template selected, press F1 and select Properties from the
pick list.

2. Set the print options in the lower portion of the window. Press CR
to return to the selection prompt on the main report screen, or
press F4 to back up and change any of the settings.

Using reports and prints as audit trails

Once you run a register in FACTS, the information updated by that
register is no longer available in the system in that format.

An example is the AR Cash Receipts & Adjustment Register. Payments
are posted in the AR Cash Receipts & Adjustments Entry program. The
register provides an audit trail of the payments, discounts, adjustments
and miscellaneous cash posted. The register has a number assigned to
it. FACTS updates these numbers by one each time you run the register.
Once this register runs, the information it has collected is written to
various programs within the system.

This is why all FACTS registers allow you to print a hardcopy before
you run them. The hardcopy gives you the opportunity to review the
data, catch any errors and fix the mistakes before they update registers.

They also serve as audit trails that can be used to help reconcile data
later on in the fiscal cycle, and they provide an additional source of
backup in case you lose register information.

How long you save these printouts depends your company’s needs. We
recommend that you save them in numerical order and by register

type.
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General Register Format

Register formats and procedures are the same in character and
graphical user interfaces. Refer to page 51.
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